
MagicInfo Author

MagicInfo has 3 product groups: Author, Server and Player. Author is used to create and publish 
content items that will be used in MagicInfo. Author supports an extensive range of authoring 
elements to help you effectively create splendid content items.

MagicInfo Author
User Guide
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Before You Start 01

Terminology

-- Shortcut
This refers to a shortcut key.

Terms and Symbols Used in This Manual
This manual describes MagicInfo using the following simple terms and symbols.

Shortcut Keys
Shortcut keys are represented in formats such as the following: 
Press Ctrl+V. 
 → This means that you must press the “V” key while holding down the Ctrl key on 
the keyboard.

Menu Commands
Menu commands are represented in formats such as the following: 
In the menu bar, click File > New Content. 
 → This means that you must select <New Content> from the <File> menu of the 
menu bar.

Text Used in the Software
The examples of typed text are represented in italics as in the following example:
Add a text element and enter “MagicInfo Author ” as the content.
→ This means that you enter Magicinfo Author in the text element.

Drag & Drop
“Drag & Drop” is a commonly used computer term which refers to dragging and 
dropping an icon or object from one location to another on the screen. To drag and 
drop an icon or object, press the left mouse button over an icon or object, move it 
while holding the mouse button down, and release the mouse button at the new 
location.

MagicInfo Author
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Key Features
Author is a tool used to create effective presentations and interactive content by 
arranging various elements. Content items are managed and integrated by the 
server, and thus can easily be used, searched and published.

Various Display Options

∙∙ Standard resolution and customized resolution
∙∙ Max. resolution: 5000 x 5000
∙∙ Original Size / Fit to Screen / Lock Aspect Ratio

Designing with Elements

∙∙ Constructs a screen divided into multiple elements
∙∙ Elements can be resized, rotated or aligned
∙∙ �Supports various elements (Shape, Flash, Images, Input Source, Office, Sound, 

Text, Video, Web, etc.)

An easy and convenient editing environment

∙∙ Supports <Undo> and <Redo> features
∙∙ Supports drag & drop
∙∙ Reuses content items through templates
∙∙ Offers detailed editing using the zoom-in/out feature (10 to 200%)

Designing with Layers

∙∙ Supports overlapping layers, in which elements can be grouped

Using a Timeline

∙∙ Offers intuitive scheduling of content using a timeline
∙∙ �Controls the playing duration of an element precisely down to 1/100 of a 

second.

Presentations with Pages

∙∙ Supports presentations using multiple pages
∙∙ Previews each page
∙∙ �A background image can be added to a page and displayed to fit the screen or 

displayed in the original size, as a tile effect or in a locked aspect ratio.
∙∙ Interactive content can be created using pages.

Preview Feature

∙∙ Previews each page
∙∙ Pages can be previewed starting with a selected page.

Reusing Content

∙∙ Supports Clip Art media files
∙∙ Content designing using templates.
∙∙ User-created pages can be registered as templates.
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Various Effects

∙∙ �Offers various effects, such as Alpha, Push, Reveal and Fade.
∙∙ Supports slide transition effects between pages

Interactive Content  

∙∙ Controls events by content items, pages or elements
∙∙ Supports a programming model for each element
∙∙ Supports programming using VBScript
∙∙ �Supports various types of processing (moving between pages, changing 

element properties, etc.) directed by commands, such as touch.

Publishing To Various Types of Media

∙∙ �Publishes content to a content management server, USB memory device or 
external disk

Compatibility

∙∙ �Content created using MagicInfo Pro can be converted to the format of 
MagicInfo Author.

∙∙ �Content created using MagicInfo Advanced Edition Author can be converted to 
the format of MagicInfo Author.

System Requirements

Hardware

CPU: Dual Core 2.5GHz or higher
RAM: 2GB or greater
DISK: 50GB or greater

Software

IE 6.0 or later and DirectX

System

Windows platforms
Windows (2000/2003/XP/Vista/7/10)
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Restrictions

∙∙ �The maximum resolution is 5000x5000. Reducing the number of horizontal pixels 
will not allow for more vertical pixels, and vice versa.

∙∙ �The range of elements or functions that can be applied to content varies depending 
on the player type selected when content is created.

∙∙ �Using the Input Source function is limited if you set the screen orientation to portrait 
when creating content.

∙∙ �The maximum number of pages that can be added to a content item depends on 
the memory capacity of the PC.

∙∙ �While copying and pasting pages, the processing speed will decrease if multiple 
pages are selected and/ or there are many elements on a page.

∙∙ �The maximum number of elements that can be added to a page depends on the 
memory capacity of the PC.

∙∙ �While copying and pasting elements, the processing speed will decrease if many 
elements are selected.

∙∙ Only VB Script is supported.

∙∙ �Script is an interpreter language and most errors can only be identified when Script 
is run. Errors that appear while Script is running can be identified by performing a 
preview. When a function is registered, only basic syntax errors are identified.

∙∙ �While previewing content, the processing speed will decrease if multiple pages are 
selected and/ or there are many elements on a page.

∙∙ �Playback is only supported by MagicInfo once the file is completely downloaded.

∙∙ �When using a content item from MagicInfo Pro in MagicInfo, there will be minor 
changes in function as follows : 

* The <Original Size> option cannot be applied to a <Flash> element.
* The <Border> and <Offset> properties cannot be applied to a <Web> element.
* �The interval for the Refresh property is rounded up to the next minute (ex. 35 seconds 

becomes 1 minute).
* �Each effect is replaced with a similar effect. This is because <MagicInfo> uses different 

effects than <MagicInfo Pro>.

∙∙ �To use <Firefox> elements, <Firefox> must be installed on the PC. To open a web 
page by entering a URL, the Internet must be connected.

∙∙ �To use <Office> elements, the viewer corresponding to the file format (Word, Excel 
and/or PowerPoint) must be installed.

∙∙ To preview <PDF> elements properly, the PDF viewer must be installed.

∙∙ �To use <Web> elements, Internet Explorer must be installed.

∙∙ �To properly preview or view <Flash> elements in thumbnail format in the <Stage 
window> or <Pageline> window, the Flash player corresponding to the Flash file 
must be installed.
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∙∙ �To properly preview or view <Video> elements in thumbnail format in the <Stage 
window> or <Pageline> window, the codec corresponding to the video file must be 
installed.

∙∙ �The <Office> elements Excel and Word are displayed in full screen and not within 
the element frame.

∙∙ �<Web>, <Office>, <PDF> and <Flash> (if Window Mode is TRUE) elements are 
window based and thus always displayed on top of other elements on the screen 
even if their priority or layer is lower than other elements. However, a higher priority 
window based element will be displayed on top of a lower priority window based 
element.
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Install

Execute the program installer 
file to start the MagicInfo Author 
installation process.
Specify the installation language.

Click [Next] to start the install 
wizard.

Agree to the terms of use, then 
install the program according to 
the displayed instructions.

Uninstall

Click [Start] - [All Programs] - 
[MagicInfo Premium] - [Author] 
- [Uninstall MagicInfo Author] 
to start the program uninstall 
process.

Click [Uninstall]. Program 
uninstallation starts.

A confirmation window appears 
prompting if you want to delete 
user settings files.
Select the desired option.

The program has been 
uninstalled.

Installing and Uninstalling the Program
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Using Tools 02

Getting Started with Content Authoring
Create a content item in the start-up screen of Author to open the <Contents 
Setting> window. Configure the basic settings for the content item you are 
creating.

MagicInfo Author
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Contents Setting Window

Contents Name Assigns the name of the new content item.

Player Type

Select a MagicInfo Player that will play 
content. 
This feature may vary based on your Player 
model.

Background music file
Registers the background music files (.WAV, 
.WMA, .MID, .MP3) that will be used while 
content is played.

Display Option

Sets the aspect ratio or size of original 
content that will be published and played 
on the display device. <Lock Aspect Ratio>, 
<Fit to Screen> or <Original Size> can be 
selected.

Resolution

Sets the resolution that will be applied by 
default when a new content item is created. 
The resolution is set to 1366 X 768 by 
default.

Width
Sets the width of the content item in pixels. 
If you enter a number, the resolution is 
changed to custom setting.

Height
Sets the height of the content item in pixels. 
If you enter a number, the resolution is 
changed to custom setting.

After you have completed the settings, click <Create with Wizard> or <Create> 
to open the content authoring page. (Click <Create with Wizard> to open the 
<Content Wizard> for help with content authoring.)

Tips

The term “MagicInfo Player” refers to all MagicInfo 
Player versions which include I, S, S2 and S3.

-- Lock Aspect Ratio
Plays the content in the resolution of the display 
device. The aspect ratio of the original content 
item is retained.

-- Fit to Screen
Plays the content in the resolution of the display 
device. The aspect ratio of the original content 
item can be changed.

-- Original Size
Plays the content in the original resolution 
regardless of the resolution of the display device.
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Using Content Wizard
Content Wizard helps you create content more easily. You can insert a file into 
various layout samples.
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Select a content item. The content item is 
created according to the layout shown in 
the thumbnail.
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Select a file you want to play in each 
section according to the previously 
selected content layout.
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To insert a header text into a content 
item, enter the text, check the <Header 
Text> checkbox and configure the header 
text settings. If you do not want to insert 
a header text, do not check the <Header 
Text> checkbox.
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To insert a footer text into a content 
item, enter the text, check <Footer Text> 
checkbox and configure the footer text 
settings. If you do not want to insert a 
footer text, do not check <Footer Text> 
checkbox.
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Confirm the settings you have configured 
in the <Content Wizard>.
To modify your settings, select <Back>. If 
your settings are correct, select <Finish> 
to finish the Content Wizard.
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The page is displayed according to the 
settings configured in Content Wizard. 

Tips

-- Header Text and Footer Text Options

Content You can enter content here.

Overlap Determines whether the 
header and footer text will 
overlap the image applied 
to the page.

Text Color Specifies the color of text.

Text Size Specifies the font size of 
text.

Background 
Color

Specifies the background 
color of the header and 
footer text.

Opacity Specifies the opacity of the 
background.

Movement 
Direction

Sets the header and footer 
text as captions and sets 
the scroll direction of the 
captions.

Movement 
Speed

Sets the header and footer 
text as captions and sets 
the scroll speed of the 
captions.
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Screen Organization
Author is used to create and control content items using the Stage, Design and 
Design Setup windows.

Screen Components

1

2 4

5
3

1 Menu Bar and Toolbar

2 Design window

3 Design Setup window

4 Stage window

5 The Timeline and Pageline windows

Tips

-- Displaying Content Information
The file name of a content item currently being 
created is displayed on the title bar at the top 
of the Author screen. The content information 
display bar at the bottom indicates any lock keys 
that are turned on (Caps Lock, Num Lock and 
Scroll Lock) and displays information about a 
content item currently being created, such as the 
page name, resolution, page order and playing 
duration.
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Menubar
The menu bar is placed at the top of the screen and contains all commands 
supported by the program. It consists of 7 menus and their submenus. Each 
submenu has an icon to the left of it and shortcut key to the right of it.

Shortcut key

Toolbar icons

Functions

1. File (F)

Manages content files.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

New Contents (N)

Opens a new content item. If a content item is already being created, you will be 
prompted to save the content item before creating a new one.
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�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.
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New DataLink Template (T)

Create a new DataLink template. A DataLink template allows you to organize dynamic 
data, which can change over time, using collected data as elements.
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플레이어는 3개의 구성요소가 있습니다.
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Open (O)

Opens a created content item or content item being created.
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플레이어는 3개의 구성요소가 있습니다.
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Save (S)

Saves a created content item or content item being created.
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플레이어는 3개의 구성요소가 있습니다.
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Save As (A)

Saves a created content item or content item being created under a different name.
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플레이어는 3개의 구성요소가 있습니다.
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Close (C)

Closes the content item currently being created.
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플레이어는 3개의 구성요소가 있습니다.

�
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��

Preview selected page (V)…

Previews one selected page.

Tips

-- Shortcut Keys
In general, a menu item can be accessed using a 
mouse, which involves going through a series of 
other related menus. However, a menu option can 
be accessed more quickly by using shortcut keys. 

For example, if you press Ctrl+S, the <Save> 
function is directly executed.

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (of the menu bar or a toolbar) when a 
defined area or number of elements are selected.

-- Close
Save and then close the content item. When the 
content item is closed, the Author start-up screen 
will appear.



16

�
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�

플레이어는 3개의 구성요소가 있습니다.

�
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��
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��

��

��Preview from selected page (F)...

Previews from the selected page to the last page sequentially.
�

�
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�

�

�

�

플레이어는 3개의 구성요소가 있습니다.
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��

Publish (P)…

Publishes a created content item or a content item in the process of being created to the 
local drive, external drive, or server.
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�

�

�

플레이어는 3개의 구성요소가 있습니다.
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��

Exit (X)

Exits Author.

2. Edit (E)

Provides submenus for editing.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�
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��

Undo (U)

Cancels the latest command.
�

�
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�

�

�

�

플레이어는 3개의 구성요소가 있습니다.
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��

Redo (R)

Redoes the cancelled command.
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�

플레이어는 3개의 구성요소가 있습니다.
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��

Cut (T)

Cuts the selected element or object.
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�

플레이어는 3개의 구성요소가 있습니다.
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Copy (C)

Copies the selected element.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Paste (P)

Pastes the cut or copied element or object.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Delete (D)

Deletes the selected element or text.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Select All (A)

Selects all elements or objects in the current page.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��Cancel Select All (S)

Cancels the selection.
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3. Page (P)

Provides submenus regarding pages.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

New Page (N)

Adds a page to the content item currently being created.
�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Duplicate Page (U)

Copies and adds the selected page.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Delete Page (D)

Deletes the selected page.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Delete All Pages (A)

Deletes all pages in the content item currently being created.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Edit Previous Page (P)

Returns to the page previous to the one currently being created.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Edit Next Page (X)

Moves to the page subsequent to the one currently being created.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Edit First Page (F)

Moves to the first page.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��Edit Last Page (L)

Moves to the last page.
�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Import Page (I)

Imports the saved page and includes it in the content item currently being created.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Export Page (E)

Saves the selected page under a different name.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Register Template (T)

Registers the selected page as a template so that it can be used later.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (of the menu bar or a toolbar) when a 
defined area or number of elements are selected.

-- Differences Between a Page and a 
Template

If a page is exported, the page is saved without 
packaging external files such as images and 
videos included in the page. For example, if a 
page which contains an image file is exported, 
the page will be saved without saving the image 
file. This means that if the location of the image 
file used for a page when the page is exported 
is different from when the page is imported, the 
image will not be loaded. A page registered as 
a template is saved by packaging all the files 
contained in the page. Thus, the page can always 
be imported and reused.
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4. Design (D)

Performs tasks required for creating a content item, such as adding or placing 
design elements.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Add (A)

Adds elements from the elements list provided by Author to the current page.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Order (O)

Changes the arrangement of the elements selected from the elements list.

Bring up to the Front (F)

Moves the selected element to the very front.

Send down to the farthest Back (B)

Moves the selected element to the very end.

Bring to front for one step (R)

Switches the position of the element with the preceding element.

Send to back for one step (A)

Switches the position of the element with the following element.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (of the menu bar or a toolbar) when a 
defined area or number of elements are selected.
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�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Align (N)

Aligns elements selected from the elements list.
They will align with the last selected element.

Align Top (T)

Aligns the selected elements to the line above.

Align Center (C)

Aligns the selected elements to the center line.

Align Bottom (B)

Aligns the selected elements to the bottom line.

Align Left (L)

Aligns the left sides of the elements.

Align Center (E)

Aligns the centers of the elements vertically.

Align Right (R)

Aligns the right sides of the elements.

Distribute Horizontally (H)

Sync the horizontal spacing between the sides of the selected elements.

Distribute Vertically (V)

Sync the vertical spacing above and below the selected elements.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Size (S)

Equalizes the size of elements selected from the elements list.
They will equalize to the last selected element.

Original Size (O)

Restores the image to the original size.

Make Width the Same (W)

Equalizes the width of the selected elements.

Make Height the Same (H)

Equalizes the height of the selected elements.

Make Size the Same (S)

Equalizes the width and height of the selected elements.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (of the menu bar or a toolbar) when a 
defined area or number of elements are selected.

-- Align, Size, Group
The <Align> and <Size> commands can be 
selected and used when more than one element 
is selected. When the <Align> and <Size> 
commands are applied to the selected elements, 
the last selected element becomes the key object. 
The last selected element is enclosed by a green 
frame.
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�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Group (G)

Selected elements can be grouped or grouped elements can be separated.

Group (G)

Groups the selected elements.

Ungroup (U)

Separates the grouped elements.

5. View (V)

Displays the windows on the screen. An option is enabled when the corresponding 
window is hidden and disabled when the corresponding window is displayed.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

File Window (F)

Displays the File window.
�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Element Window (L)

Displays the Element window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Template Window (T)

Displays the Template window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Server Content Window (S)

Displays the Server content window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

DataLink Window (D)

Hide or display the DataLink window. 

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Effect Window (E)

Displays the Effect window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Properties Window (P)

Displays the Properties window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��Appending window (A)

Displays the Appending window.
�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Favorite Window (V)

Displays the Favorite Window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�
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��

��

��

��

��

Timeline Window (M)

Displays the Timeline window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Pageline Window (G)

Displays the Pageline window.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Initialize layout (I)

Changes the customized layout to the default layout.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (in the menu bar or a toolbar) when a 
defined area or number of elements are selected.
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6. Setting (S)

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Contents Setting (S)

Changes the basic content settings such as the content name, background music, and 
size.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Option (O)

Changes the overall Author system settings, such as Design, Server, Script and Log. 

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Script Editor (E)

Launches Script Editor.

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Script Wizard (W)

Launches Script Wizard.

7. Help (H)

�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

Help (H)

Displays help manual for MagicInfo Author.
�

�

�

�

�

�

�

�

플레이어는 3개의 구성요소가 있습니다.

�

��

��

��

��

��

��

About MagicInfo(A)

Displays the version and copyright information for MagicInfo Author.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (in the menu bar or a toolbar) when a 
defined area or number of elements are selected.
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Toolbar
The toolbar is a collection of command icons (Design, Element and Font) displayed 
under the menu bar. If you select a window, element or page, the available 
command icons are enabled.

Toolbar Configuration
Toolbar consists of the Design, Element, and Font toolbar.
Each tool within the tool bars can be customized, displayed or hidden.

Design toolbar

The Design toolbar is a collection of tools required to design content items.

Element toolbar

The Element toolbar is a collection of key elements used for designing.

Font toolbar

The Font toolbar is enabled for <Text> element but disabled for other elements.

Tips

-- Disabling an Option in a Submenu
You can control what options are enabled in a 
submenu (of the menu bar or a toolbar) when a 
defined area or number of elements are selected.
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Customizing Toolbars
The Author toolbars can be customized as required. They can be hidden, displayed 
or moved. Customized toolbars retain their new configuration even after Author is 
exited.

1 2 3

4

1 To move a toolbar, drag and drop the title bar of the toolbar.

2 To change the shape of a toolbar, drag and drop an edge of the toolbar.

3 To display or hide a toolbar, open the context menu by right clicking the toolbar or menu 
bar. A toolbar displayed on the screen is indicated by a V symbol.

4 To choose the icons you want displayed in a toolbar, click  and then click <Add or 
Remove Buttons>. Hide the  of any icons you want hidden or select a hidden icon you 
want displayed so that the  reappears. Click <Reset Toolbar> to return the toolbar 
icon to the original status.
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Moving a Toolbar
Click the drag area of a toolbar to display the  shaped mouse cursor. With the 
mouse button pressed, drag and move the floating toolbar. Drop the toolbar to the 
desired area. The toolbar will dock in the new location. The toolbar can only be 
docked to one of the 5 positions shown below.

1

2

3 4

5

Terminology

-- Floating
Usually “Float” means to “lie” on or just below the 
surface of a liquid or “move gently” in the air. In 
this manual, floating refers to when a window is 
not fixed in a certain area, but is floating and can 
be moved as required.

-- Docking
Usually “dock” means to manoeuvre into or next 
to a dock or “wharf.” In this manual, docking 
refers to fixing a window in a certain area.
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Context Menu
The context menu shows the commands for the currently active window or selected 
area. Using the context menu, you can select a command more quickly. To open 
the context menu, right click the selected area. The menu options in the context 
menu differ depending on the area you have clicked on.
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Window Configuration

File Window
The File window browses local drives in <View List> or <View Thumbnail> mode. 
Saved content item can be loaded and documents or media files saved to disk can 
be imported to a content item currently being created. The documents or media 
files can be added directly to the <Stage window> by dragging and dropping them. 
An added file in the <Stage window> automatically becomes an element.

If you double-click a content file, you will be prompted to save the content item 
currently being created and the newly selected content file will be opened.

1

2

3

1 This shows the current file location.

Returns to the previous folder.

Moves to the last folder after having clicked .

Shows a list of the previously selected folders.

2 Browses folders and files.

3 Selects a file viewing option.
If the <Show Supported Files Only> checkbox is checked, only files supported by Author 
are displayed. If this checkbox is unchecked, all files are displayed.

Shows files in a thumbnail format.

Shows files in a list format.

Terminology

-- View Thumbnail Mode
Files are displayed as small thumbnail images.

-- View List Mode
Files are displayed in a list.
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Element Window
The Element window contains elements that can be selected from several different 
categories and inserted into a content item. A category can be selected by clicking 

. Categories contain different elements.

Template Window
The Template window, offers Clip Art and Templates media files and allows you to 
register and use the pages you have created.

In Clip Art , you can import a media file supported by MagicInfo Author.
In Templates , you can insert registered pages into the content item currently 
being created.

Tips

-- Element
For more information about elements, refer to the 
“Elements” section.

-- Template
For more information about templates, refer to the 
“Using Templates” section.
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Server Contents Window
The Server Contents window displays media files registered on the connected 
server. View LFD files created and registered by Author or download registered files. 
The server content items can be refreshed by clicking <Reload>.
The Server Contents window is comprised of  and .
The media files registered in server can be loaded to .
The pages registered in server can be inserted  to the content in .

To download a media file, select a file registered on the server and drag it to the 
Stage window.

Select <Yes> to finished.

An example of a selected file that has been dowloaded and registered to a page is 
shown above.

Caution

-- Server Contents Window
To use the Server Contents window, the Internet 
and MagicInfo server must be connected. For 
more information about the server settings, refer 
to the “Configuring the Options and Publishing 
Content” section.
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Properties Window
The Properties window, sets the properties and events for a selected element or 
page. Properties of elements containing the Custom feature can be configured by 
clicking the <Custom Setting> button.

This opens the <Properties window> where properties for the selected element or 
page can be configured.
This opens the Event window where events for the selected element or page can be 
configured.
This opens the <Custom Setting> window which is enabled if the selected element 
contains the Custom Setting function.

Effect Window
The Effect window offers, various effects that can be selected and applied to 
elements.

�Tips

-- Note
For more information about events, refer to the 
“Events” section.

For more information about effects, refer to the 
“Effects” section.
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Appending Window
The Appending window offers elements containing files, folders or sub folders 
that can be added to a page. The files, folders or sub folders can be added as 
attachments by clicking the buttons at the bottom of the window.

Favorite Window
The Favorite window displays file information (file name, size, format, and 
duration). If you register a file to the page currently being created, it is 
automatically registered to the Favorite window. To register a file to Favorite 
that isn’t registered to a page, drag the file from the File window to the Favorite 
window. The file information will be saved along with the content item. 

Note that if a content item is closed, the corresponding file information 
automatically disappears. If the content item is imported again, the file information 
reappears. To refresh the file information, click <Reload>.

Tips

-- Note
For more information about the Appending 
window, refer to the “Using the Appending 
Window” section.
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Timeline Window
The Timeline window is automatically enabled if an element is added to the Stage 
window. The timeline displays the arrangement of elements and allows you to 
group elements and organize them into layers. You can preview playback of the 
page currently being created in the Stage window and control the start time, end 
time and duration.

4 5 6 7

2
1

3

1 Shows the resolution and duration of the page.

2 Folds the layer to shows the elements contained in the layer as 
a group.

Shows all the elements contained in the layer.

Hides the elements contained in the layer in the Stage window.

3 Shows the arrangement of elements and sets the start time, end time and duration for 
each. Each time bar can be moved using the mouse. The duration can be increased or 
decreased by dragging the edge of the time bar. Elements can be moved up or down 
and the arrangement of elements can be changed by dragging and dropping them. If 
you move the mouse cursor over an element, the thumbnail for the element will appear.

Hides or displays the element in the Stage window.

Locks the element to the Stage window.

Shows the path of an animated element on the page.

4 Adds a layer.

Deletes the top layer.

5 Plays the page that is currently being created in the Stage window.

Slows down the page playing in the Stage window.

 Plays or pauses the page playing in the Stage window.

Stops the page playing in the Stage window.

Speeds up the page playing in the Stage window.

Displays the speed of the page playing in the Stage window.

6 This zooms in on or out of the timeline track. Zoom in to adjust the position and 
duration of tracks more precisely.

7 Displays a Time marker on the timeline. Move the time marker along the timeline to 
preview a frame of the page. You should see all elements that occur in the frame.

Tips

-- Note
For more information about the Timeline window, 
refer to the “Using the Timeline Window” section.
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Pageline Window
Both finished and incomplete content items are displayed in pages.

4

2
1

3

1 This allows you to find a page more easily using the search function.
To find a page, enter the title of the page you want to find.

2 This displays pages in thumbnail formats. If the mouse cursor is moved over a page, the 
page name, Resolution and Duration are displayed.

3 Adds a blank page.

Deletes the selected page.

Copies the selected page.

Pastes the copied page.

4 This displays the page for global elements when checked. Uncheck to hide the page.

Stage Window
Elements can be added in the Stage window when a content item is created using 
Author.

Tips

-- Note
For more information about the Pageline window, 
refer to the “Using the Pageline Window” section. 

-- Search Function
If you search for a page using the search function, 
all pages containing the entered text are displayed 
in order of page number.

Terminology

-- Page for Global Elements
Elements displayed on the <Page for Global 
Elements> are displayed on every page. Check 
the <Page for Global Elements> checkbox in 
order to avoid having to manually add the same 
element to every page.

Tips

-- Note
For more information about the Stage window, 
refer to the “Using the Stage Window” section.
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Customizing the Layout
The Author layout can be defined as required. A window can be resized, moved, 
hidden, unhidden and grouped as required according to the type of task. After 
changing the layout, it will remain as is, unless changed again or restored to the 
original layout.

Changing the Window Layout
Windows can be floated, docked, resized, hidden or unhidden, and grouped to 
optimize your working environment.

Floating
If you drag the title bar of a window, the window changes to a floating state and 
can be moved. While a window is being moved, only the edges of the window are 
displayed.

Docking
To dock a floating window, drag the window into a docking area.

Terminology

-- Layout
The layout is the arrangement of elements on the 
page currently being designed and edited.

-- Floating
Usually “Float” means to “lie” on or just below the 
surface of a liquid or “move gently” in the air. In 
this manual, floating refers to when a window is 
not fixed in a certain area, but is floating and can 
be moved as required.

-- Docking
Usually “dock” means to manoeuvre into or next 
to a dock or “wharf.” In this manual, docking 
refers to fixing a window in a certain area.
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Grouping Windows
Floating windows can be grouped in a variety of shapes.

Resizing a Window
A window can be resized by dragging an edge of the window.

An Example of a Customized Layout
Various layouts can be created and used. Notice each picture in the example below 
is a different size and shape.

Tips

-- Initializing the Layout
In the menu bar, click View > Initialize layout to 
initialize the changed layout.
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Using the Stage window
Add an element to the Stage window to create a content item.
One page from the content item is displayed in the Stage window. Move to another 
page using the Pageline window.

Adding an Element to the Stage window
The most basic way to add an element to the Stage window is to drag and drop the 
element from the Design window to the intended position in the Stage window.

Tips

-- Design window
The Design window offers objects that can be 
represented in the Stage window. Different 
objects are available in the File window, Element 
window and Server Contents Window.
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Zooming In on and Out of the Stage Window
The Stage window can be zoomed in or zoomed out by using the Design toolbar.

A zoomed in Stage window will not display the entire page. Refer to the the 
thumbnail of the page in the Pageline window for the full image. The part of the 
image displayed in the Stage window is indicated by a green rectangle.

Tips

-- MoveMode
To move to an area on the current page, 
right-click over the Stage window and select 
<MoveMode> from the context menu. 

If the mouse cursor changes to , you can move 
the zoomed-in page.

To cancel the movement and return to the original 
mouse cursor, right-click over the Stage window 
and click <Select>.
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Tips

-- Ruler
Rulers are displayed at the top and left side of 
the Stage window. They can be used to arrange 
elements more precisely.

-- Snap Object to Another Object
Even if <Snap Object to Grid> is not enabled, you 
can still perform the function: move the element 
while pressing the Alt key on the keyboard.

Note that if <Snap Object to Grid> is enabled, 
moving the element while pressing the Alt key will 
disable the function.

Ruler
Rulers can be displayed in the Stage window. 
To display the rulers, right-click in the Stage window and select <Ruler>.

Grid and Guideline
A grid and guidelines for arranging elements in the Stage window can be displayed. 
Right-click in the Stage window and select <Grid and Guideline>. A window will 
appear where the grid and guidelines can be configured.

Snap Object to Grid Moves an element in alignment with the grid.

Snap Object to 
Another Object

Moves an element in alignment with another 
object in the Stage window. A moving element is 
induced to align to an object passing by.

Show Grid Displays a grid on the screen. The interval of the 
grid can be 10, 20, 30, 50, 100, 150 or 200 pixels.

Show Guideline

Displays guidelines on the screen. The guidelines 
divide the Stage window vertically into 4 equal 
sections. Using the guidelines, you can align a new 
content item to the center of the Stage window.
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Elements
Author provides various authoring elements, simply called elements in the 
instructions of this manual, that are necessary for authoring content, each with 
unique properties. Elements are categorized into Widget, Multimedia, Other, 
Shapes, Event Raiser, Stickers, or Visual Effect. Each category contains different 
elements. Click  to select a category.

Inserting an Element
Elements can be added in 7 ways.
An element can only be added to the Stage window.

Drag files on the local drive to the Stage window through the File window.

Drag an element provided by Author to the Stage window through the Element 
window.

Drag a Clip Art media file provided in the Template window to the Stage window.

Download an element from the MagicInfo Server through the Server Contents window 
and drag it into the Stage window.

Drag an element from the Element toolbar and drop it to the required location in 
the Stage window. For an added element that requires a file, the Open window 
automatically appears where you can select a file you need.

Right-click over the Stage window to open the context-sensitive menu. Click <Insert 
element>, select an element to be added, and arrange it by dragging it. For an added 
element that requires a file, the Open window automatically appears where you can 
select a file you need. 

Drag an element registered to the Favorite window to the Stage window.

Tips

-- Element Category
Elements can be divided into seven groups.

Widget Access widget elements 
to display the clock and 
weather forecast.

Multimedia Camera Access multimedia 
elements to display images 
and video/audio contents.

Other Access elements used 
to display webpages, 
documents and tables.

Shape Access various shape 
elements.

Event trigger Access elements that are 
not visual but still influence 
events.

Sticker Use a variety of stickers.

Visualization Select from confetti, snow, 
rain, and mist elements to 
add visual effects on the 
page.

-- Inserting an Element
When elements are added to the Stage window, 
some of them are displayed in the Stage window 
but others are not. For example, a Shape element 
is displayed, arranged and designed in the Stage 
window, but an element of the Event Raiser 
category is not displayed in the Stage window 
because it deals with a script or event.

-- Restrictions when applying elements
The range of elements that can be applied to 
content varies depending on the player type 
selected when content is created.
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Handling Elements
Added elements can be handled in various ways (e.g. moving or resizing). If you 
know exactly how to handle elements, you can create content more easily.

Moving an Element
You can move an element by clicking and dragging it.

Resizing an Element
You can resize an element by dragging a green handle that appears when an 
element is selected.

Rotating an Element
You can rotate an element by dragging the red handle that appears when selecting 
an element.

Tips

-- Copying an Element
Press Ctrl + C on the keyboard.

-- Cutting an Element
Press Ctrl + X.

-- Pasting an Element
Press Ctrl + V.

-- Moving an Element
Move the element while pressing the Shift key. 
The element can be moved either vertically or 
horizontally.

-- Resizing an Element
Select the element and drag the green handle 
while pressing the Shift key. The element will be 
resized in direct proportion.

-- Rotating an Element
Select the element. When a red handle appears, 
drag the handle in the direction you want to rotate 
the element while pressing the Shift key. The 
element will rotate in 15 degree increments.
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Transforming an Element
You can transform an element by dragging the yellow handle that appears when an 
element is selected.

Clipping an Element
You can clip an area when editing an element.
If you click  after arranging an element, the mouse cursor changes to . Place 
the cursor over one of the handles of the element and drag it. The area covered by 
the rectangle marquee will be clipped.

Tips

-- Clipping an Element
You can select a particular area of the image by 
using the clipping function.
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The Order of Elements
The order of elements can be changed using 4 different methods.

In the menu bar, click Design > Order.

Select an element, right-click over the element and select <Order>.

Change the order of the elements using the Design toolbar.

Rearrange elements in the Timeline window.
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Selecting Multiple Elements
You can select one or more of the elements moved to the Stage window. Click 
the intended files or elements while holding down the Ctrl key or first deselect all 
elements and select the targets by dragging the mouse over the screen.

When more than one element has been selected in the Stage window, the last 
selected element is the key element. The element is a reference for changing the 
order of, aligning and resizing the other elements.

The selected elements can be moved as a group, aligned to the key element or 
equalized to the size of the key element.

Multiple elements can also be selected in the Timeline window.

Click files or elements while holding down the Ctrl key.

Alternatively, you can select multiple elements by pressing Shift in the Timeline 
window.
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Aligning Elements
When more than one element is displayed, one element can be aligned to the top, 
center, bottom, middle, left or right of the other element. Elements are aligned to 
the last selected element.

There are 3 ways to align elements.

In the menu bar, click Design > Align.

Select an element, right-click it and select <Align> from the popup menu.

Align elements using the Design toolbar.

Tips

-- Align, Size and Group Functions
The Align, Size and Group functions are enabled 
when more than one element is selected.



44

Equalizing the size of Elements
When arranging more than one element, the horizontal or vertical size of the 
elements can be equalized with the last selected element.

There are 2 ways to resize elements.

In the menu bar, click Design > Size.

Resize elements using the Design toolbar.

Grouping Elements
Multiple elements can be grouped and used like a single element.

In the menu bar, click Design > Group to group elements or cancel a 
grouping.

Group elements or cancel a grouping using the Design toolbar.

Tips

-- Align, Size and Group
The Align, Size and Group functions are enabled 
when more than one element is selected.

-- Grouping and Ungrouping Elements
To group the selected elements, click <Group>. 
(The <Group> menu item is only enabled when 
theelements are not grouped.)

To cancel the grouping, click <Ungroup>. (The 
<Ungroup> menu item is only enabled when the 
elements are grouped.)
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Repeating Elements
The Flash, Video, Sound, Text, Shape and WordArt elements supported by Author 
support the repeat play function. Elements can be repeated at a specified time 
interval.

The repeat play function provides 2 options: <Repeat until the Designated Time> 
and <Loop>.

Playing an Element

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Add an element to be repeated.
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While the element is selected, open the Properties window and look at the 
<Play> section.
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If you click the  button in <Duration Policy>, a dropdown list of duration 
policies is displayed. Select either <Repeat until the Designated Time> or 
<Loop>.

Repeat until the 
Designated Time

Repeats the element until a specified time 
within the duration of the page.

Loop Repeats the element continuously until the 
duration of the page finishes.

Tips

-- Repeating an Element
The Repeat function plays an element on a page 
repeatedly. Even if the element is set to repeat for 
long hours or indefinitely, it stops repeating when 
the duration of the page finishes.

To repeate the element continuously without a 
time limit, select <Finish in last element time> as 
<Duration Policy> in the page properties. Because 
the element is set to repeat continuously, the 
page will be played continuously.
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The <Repetition Time> and <Stop Repetition Time> options at the bottom 
are activated. Configure the <Repetition Time> and <Stop Repetition 
Time> options.

Repetition Time

This option is used to set the interval for 
repeating the element and is enabled when 
<Repeat until the Designated Time> or 
<Loop> is selected as a playback option.

Stop Repetition Time

Sets the time to stop repeating the 
element. This option is enabled when 
<Duration Policy> is set to <Repeat until 
the Designated Time> or <Loop>. When 
<Loop> is selected, the <Stop Repetition 
Time> option is not applied.
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The screen below shows the timeline tracks where elements are set to be 
repeated.

Locking an Element
An element can be locked to the Stage window. A locked element cannot be moved 
and the properties cannot be changed. Right-click over the element added to the 
Stage window or Timeline window, and select <Lock Element> to lock the element. 
Right-click a locked element and select  again to release the locked element. 

Tips

-- Stop Repetition Time
This option is only enabled when the <Duration 
Policy> is set to <Repeat until the Designated 
Time> in Step 
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Globalizing an Element
To arrange the same element in the same position on all pages when creating a 
content item, you normally have to repeat the same actions. This situation can be 
avoided by globalizing elements.

A globalized element is moved to <Page for Global Elements>. Globalized elements 
are displayed on every page but can only be edited in <Page for Global Elements>. 
If you right-click over an element added to the Stage window and select <Globalize 
Element>, the element is moved to <Page for Global Elements>. A globalized 
element can be deleted or transformed in <Page for Global Elements>.

Favorites
Frequently used elements can be registered to the Favorites. Right-click over an 
element you want to add to the Favorites and click <Move To Favorites Category>. 
The element will be moved to the Favorites. Here, the Favorites category is created 
in the Element category and the element moved to the Favorites category is 
removed from its original category. To return the element to its original category, 
right-click over the element moved to the Favorites Category and select <Move To 
Original Category>.
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Selecting All Elements
To select all the elements in the Stage window, right-click over the Stage window or 
an element and click <Select All> from the context menu.

Previewing Elements
To cancel previewing an element, add an element to the Stage window, right-click 
and select <Preview> from the context menu. The element is represented by an 
icon. To preview the element, click <Preview> again.

Tips

-- Maximizing an Element
To maximize an element added to the Stage 
window, double-click it.
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Element Properties
The properties of elements added from the Element window to the Design window 
can be configured in the Properties window. Select an element in the Stage 
window or select a track corresponding to the element in the Timeline window and 
configure the properties settings of the element in the Properties window.

Key Properties

Config

Type Represents the type of element.

Name Represents the unique name of the element. (In a 
page, duplicate names are not allowed.)

Order
Sometimes elements may overlap. An element 
with a greater <Order> value will be displayed 
over an element with a lesser <Order> value.

Element Layer

This is the number assigned to the layer the 
element belongs to. The number can be changed, 
and if the number is changed, the layer of the 
element is also changed. The layer number cannot 
be larger than the total number of layers in the 
timeline.

Position

Position X Determines the horizontal start position of the 
element that will appear on the screen.

Position Y Determines the vertical start position of the 
element that will appear on the screen.

Width Determines the width of the element.

Height Determines the height of the element.

Rotation Angle
Determines the Rotation Angle of the element. 
(This is only enabled for elements that have the 
rotation angle attribute.)

Play

Player Visible Selects whether to show (True) or hide (False) the 
selected element when playing the page.

Window Mode Create a window to play pages in the window.

Duration Policy
Determines the duration policy for the element. 
Each element of a content item is played or 
stopped according to the duration policy.

Tips

-- Type of Element Properties
Element properties consist of the major properties 
common to most of the elements and the 
properties of each individual element.

-- Entering the Time
Hours: Minutes: Seconds: 1/100 second  
Example: 10 hours 2 minutes 20.34 seconds = 
10:02:20.34
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Finish in defined time Quits playing after a specified time.

Finish in last element 
time

Plays the next page immediately after the last element of the 
page is finished. (This only applies to pages.)

Wait for input Continuously plays until a designated event is triggered.

Start time Determines the start time for the element.

Duration Determines the duration of the element.

Animation 
Interpolation Type

An element can be assigned dynamic properties 
or animated. The <Animation Interpolation Type> 
determines the speed of these changes.

Event Enable Selects whether the element can receive and 
process an event while being played.

In Effect

Incoming Effect 
Name

You can select an effect to be applied when the 
element is played.

Incoming Effect 
Duration

Sets the duration of the Incoming Effect.

Incoming Effect 
Direction

Determines the direction of the Incoming Effect.

Effect Repeat Policy Sets the repeat policy for the incoming effect.

Repeat Off If this option is selected, the effect is not repeated.

Repeat the specified 
count

The effect is repeated at a specified interval for a specified 
number of times.

Repeat indefinitely The effect is repeated at a specified interval as long as the 
element is being played.

Repetition Cycle

Sets the interval for repeating the element. This 
option is enabled when <Effect Repeat Policy> is 
set to <Repeat the specified count> or <Repeat 
indefinitely>. For example, if the <Repetition 
Cycle> is set to 3 seconds, the element is played 
every 3 seconds.

Effect Repeat Count

The effect is repeated the specified number of 
times. (This option is enabled when the <Effect 
Repeat Policy> is set to <Repeat the specified 
count>.)

Tips

-- Effects
For more information about incoming and 
outgoing effects, refer to the “Effects” section.

-- Entering the Time
Hours: Minutes: Seconds: 1/100 second  
Example: 10 hours, 2 minutes, 20.34 seconds = 
10:02:20.34
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Out Effect

Outgoing Effect 
Name

Selects an effect to be applied when the element 
is terminated.

Outgoing Effect 
Duration

Sets the duration of the Outgoing Effect.

Outgoing Effect 
Direction

Determines the direction of the Outgoing Effect.

Design Option

Canvas Visible Sets whether to display the element in the Stage 
window.

Actual Object Sets whether to preview the content of the 
element when authoring.

Lock Element Sets whether to allow modifications of the 
element properties.
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Creating an Animation
An element can be transformed into an animation by creating sections. Configure 
different properties for each end of the section or set a path for the element to 
move along.

Configuring Animation Sections
You can create sections by adding a key frame and insert an animation into each 
section.
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Select the <Show the current time elements only> option in the Timeline. Time-Marker 
and Key-Frame will be displayed. The indicated Key-Frame will become one end of the 
section.

Time-Marker

Key-Frame
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Add another Key-Frame by right-clicking where you want the other end of the section 
to be.
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The area between the newly added Key-Frame and the previous Key-Frame becomes 
a section.
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You can create multiple sections by adding key frames.

Section 1 2 3 4

Tips

-- Time-Marker
To add a Key-Frame at the same point as a 
Time-Marker, right-click over the Timer-Marker 
and select <Insert Key-Frame into Selected 
Elements>.

If you select <Tracking Time-Marker>, you 
can track an animation in the Stage window by 
moving the Time-Marker.
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Creating Property-Changing Images
In a section created by using <Insert Key-Frame>, you can create an animation in 
which the properties change over time. Select the key frames at both ends of the 
section and specify different properties for each of them in the Properties window. 
The element will change according to the configured properties.
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Add an element to the Stage window and add a Key-Frame into the Timeline. Select 
each end of the section Key-Frame one by one and set the properties to different 
values.
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For example, set the <Color> for the left and right key frames to blue and amber 
respectively.
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If you play a content item with the above settings, the element color changes from 
blue to amber within the section.

Tips

-- Property-Changing Images
Most properties that can be used for dynamic 
images are represented as a number. Examples 
include Location, Size, Rotation, Weight, Color 
and Offset.



54

Tips

-- Motion Path of Elements
If you set the Motion Path of an element, you 
cannot move the element as you want. The 
element is automatically fixed to the starting point 
of the configured Motion Path.

-- Setting the Interpolation Type
If you set the Motion Path of an element and 
right-click in the configured section, you can 
select an interpolation type. The interpolation type 
determines the movement type of an element 
animation.

Creating a Motion Path Animation
A Motion Path animation is created by changing the Location properties that are 
only applied to one of the multiple animation sections.
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After adding an element to the Stage 
window, right-click to select <Motion 
Path> and <Set Motion Path>.
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Draw the path the element will move 
while holding the left mouse button down 
in the Stage window.
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If you play a content item, the element 
automatically moves along the specified 
path.
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To remove the configured Motion Path of 
an element, right-click over the element 
for which the path is set and select 
<Motion Path> and <Delete Motion 
Path>.
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Using the Timeline
The duration of each element and the priority of multiple layers can be set in the 
Timeline window. 

Creating and Adjusting Tracks in the Timeline
After adding an element to the Stage window, a track for the element, with a length 
of 1 minute, is automatically created in the timeline.

Drag the time bar along the timeline to adjust the start time of the element.

Drag the right edge of the time bar to adjust the duration.

The timeline supports a duration from 1/100 of a second to 24 hours.
You can zoom in or out on the timeline by moving the zoom bar to the left or right.

Tips

-- Time Bar
A time bar consists of an upper part (gray) and a 
lower part (blue). The upper part is the section in 
which a key frame is added and moved and the 
lower part is the section which shows the playing 
time of an element. To use animation functions, 
such as adding a key frame to the upper part 
of the time bar, select the <Show the current 
time elements only> option at the bottom of the 
Timeline window.
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Zooming In
Slide the zoom bar to the left to zoom in. You can edit the duration of a track using 
a minimum interval of 0.01 seconds.

Zooming Out
Slide the zoom bar to the right to zoom out. You can edit the duration of a track 
using a maximum interval of 10 minutes.

Further Adjustments to the Timeline
After selecting more than 1 track, you can set the tracks to play sequentially or 
synchronize their starting times, end times or play time durations by right-clicking 
in the Timeline window. The last selected track will be used as the basis for 
synchronization.

Example outcomes of the <Adjust Time> options are shown on the following 
pages.
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Same Starting Time (S)

Each track has a different start time.

The start times of all tracks are synchronized with the last selected track.

Same Ending Time (E)

Each track has a different end time.

The end times of all tracks are synchronized with the last selected track.
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Same Duration (D)

Each track has a different durration.

The durations of all tracks are synchronized with the last selected track.

Sequential Play (Q)

The tracks overlap and seem to play in a random order.

The playback order of the tracks is arranged in sequence, starting with the track 
listed at the bottom of the timeline.
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Snap Function for a Track in the Timeline
Tracks are placed in the units specified by the position of the zoom bar at the 
bottom of the Timeline window. For example, if the zoom bar is set to 5 Sec/Unit, 
tracks are also placed in units of 5 seconds.

If the track is dragged to a certain position in the timeline, a guideline will be 
displayed in units of 5 seconds.

If you release the mouse button, the track is moved to the point indicated by the 
guideline.
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Using Timeline Layers
A layer refers to a collection of tracks. When you add the first element to the 
Stage window, a layer is created that contains one track by default. You can add 
additional layers by clicking the  button in the bottom left of the Timeline 
window. In the example below, the created layer is empty and does not contain any 
tracks. Numbering starts from 0 and the layer with the bigger number is displayed 
with first priority.

Click the  button at the bottom left of the Timeline window to delete the layer 
with the biggest number. When you delete a layer, the tracks and elements of the 
layer are deleted with it.

You can move a track within a layer or to another layer by dragging it vertically.

You can display or hide a layer by selecting or deselecting the  button on the left 
side of the Timeline window. To expand or shrink a layer, click the  or  button 
above the Show layer Icon.
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Using the Pageline
You can select the page properties and create interactive content by adding and 
arranging pages.

Page Properties
Sets the page properties after selecting a page.

Config

Type Represents the type of a object.

Name Enter the title of the page. (Duplicate page titles 
are not allowed within a content item.)

Order Shows the playing order of the page.

Background

Background Color

Sets the background color of the page using 
palette or RGB values. Click the  button to open 
the Color window and set the color. Alternatively, 
you can specify the color by directly entering 
values.

Background Image
Sets the image to be displayed as the background 
of the page. Click the  button to display the 
Open window. Select a file.

Fill-in type Sets the display type for displaying the 
background image.

Original Size Displays the background image of the page in its original size.

Fit to Screen Fits the background image to the screen.

Lock Aspect Ratio Displays the background image of the page at its original aspect 
ratio.

Tile Effect Tiles the background image of the page while maintaining its 
original size.

Play

Duration Policy

Sets the playing time duration policy for the page. 
When a content item is played, each page stops 
or waits for input depending on the playing time 
duration policy.

Finish in defined time Quits playing after the designated time.

Finish in last element 
time Plays the next page immediately after quitting the last page.

Tips

-- Entering the Time
Hour: Minutes: Seconds: Milliseconds 
Example. 10 hours 2 minutes 20.34 seconds = 
10:02:20.34



62

Wait for input Continuously plays until a trigger initiates the designated event. 
The event is processed according to the script.

Duration Sets the duration of the page.

Event Enable Sets whether to allow event handling (True) or not 
(False).

In Effect

Incoming Effect 
Name

Selects the effect to be applied when the page 
begins to play.

Incoming Effect 
Duration

Sets the duration of an effect.

Incoming Effect 
Direction

Sets the direction of the incoming effect. If you 
select North, the effect moves towards the top of 
the screen.
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Managing Pages

Inserting a New Page
In the menu bar, click Page > New Page or click the  button at the bottom of 
the Pageline window to add a new page. The added page is inserted next to the 
selected page.

Deleting a Page
Select a page to be deleted and either in the menu bar click Page > Delete Page or 
click the  button at the bottom of the Pageline window to delete it.
To delete all pages, in the menu bar, click Page > Delete All Pages.

Copying / Cuting / Pasting a Page

Copy Page

Select a page to be copied and either in the menu bar, click Edit > Copy or click the 
 button at the bottom of the Pageline window.

Cut Page

Select a page to be cut and in the menu bar, click Edit > Cut.

Tips

-- Inserting a New Page
Press the Insert key on the keyboard to add a 
page.

-- Deleting a Page
Select a page to be deleted and press the Delete 
or Backspace key on the keyboard to delete the 
page.
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Paste Page

After copying or cutting a page either in the menu bar, click Edit > Paste or click the 
 button at the bottom of the Pageline window. The copied or cut page is inserted 

next to the selected page.

Selecting a Page
To select a page, click a page in the Pageline window. The page selected in the 
Pageline window is displayed in the Stage window.
In the Pageline window, you can also select a page in the Pageline window using 
the arrow keys on the keyboard.

Moving a Page
You can move a page in the Pageline window by dragging it with a mouse. Select at 
least one page.

Tips

-- Copy Page
You can use the Ctrl+C Windows shortcut key to 
copy a page.

-- Cut Page
You can use the Ctrl+X Windows shortcut key to 
cut a page.

-- Paste Page
You can use the Ctrl+V Windows shortcut key to 
paste a page.
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Move the selected page by dragging it with the mouse.

Exporting a Page
Export a page to be reused later. The process is similar to registering a template, 
but it saves the page information without packaging the page. You can reuse the 
exported page later
Select the page to be exported and in the menu bar, Page > Export Page.

Importing a Page
Just like importing a template, you can import the page information, such as the 
element properties, and reuse it later. In the menu bar, click Page > Import Page to 
display the Open window. Files with an .lfd extension are imported. Select a file and 
click the Open button.

Preview
You can preview a content item being created.

Previewing a Selected Page

Previews only one page from multiple selected pages. In the menu bar, click File > 
Preview selected page... or click the  button in the toolbar.

Preview from Selected Page

Preview the selected pages, from first to last. In the menu bar, click File > Preview 
from selected page... or click the  button in the toolbar.

Tips

-- Differences Between a Page and a 
Template

If a page is exported, the page is saved without 
packaging external files such as images and 
videos included in the page. For example, if a 
page which contains an image file is exported, 
the page will be saved without saving the image 
file. This means that if the location of the image 
file used for a page when the page is exported 
is different from when the page is imported, the 
image will not be loaded. A page registered as 
a template is saved by packaging all the files 
contained in the page. Thus, the page can always 
be imported and reused.
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Using Templates
A page being created or one that is finished can be registered as a template and 
reused later. A page registered as a template is packaged with all elements and 
element properties that were inserted during the page creation.

Registering a Template
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Select a page to be registered as a template 
and in the menu bar, Page > Register 
Template. Alternatively, right-click over a 
page to be registered and select <Register 
Template> from the context menu.
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Select a folder to save the template to.
If there is no folder you want, you can add 
a folder in the Folder window by clicking the 

 button.
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To add a folder, click the  button.

To delete a folder, select the folder to be 
deleted and click the  button.
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If the template is registered successfully 
after a folder is selected, this message 
window appears.
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The template has been registered.

Tips

-- Packaging a Template
Registering a page as a template is essentially 
saving a template as a folder. Therefore, 
packaging means saving all the elements and 
properties contained on the page in a file-format 
template, that is a folder.

Packaged template elements are saved in the 
Author-installed folder. For example, if you have 
registered a template called “Tem1”, in the 
template folder called “Test” a folder is created 
with the location “C:\Program Files\MagicInfo 
Premium\Author\Template\test\Tem1” with the 
template elements saved inside.
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Importing a Template
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Select “Template” in the Template window.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Select a folder from the drop down menu at 
the top.
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Select the template to be added and 
double-click it.
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The template page is added to the page 
proceeding the selected page.

Caution

-- �The Size of Elements Depending on the 
Resolution
When importing a template, if the resolution 
of the template and that of the content being 
created do not match, a warning message 
appears as below. Set the size of the elements 
included in the template according to the warning 
message.

Tips

-- Deleting and Renaming a Template
To delete a template, right-click the template, and 
select <Delete Template> from the context menu. 
To rename a template, right-click the template, 
and select <Rename> from the context menu.

Here, a template is a folder, so if you delete a 
template, you delete a folder. Similarly, if you 
delete a folder, you delete the corresponding 
template. 

Note that you cannot delete or rename a template 
that is being used in the current page.
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Sound Effects
In Author, you can use sound in many different ways. You can insert background 
music (which will be played throughout the content item) into the timeline or insert 
a Sound element into the Stage window, and synchronize it with a particular video. 
When adding multiple sounds to one page, it is recommended that you take the 
playing order into account.

Inserting Sound
You can insert sound in various ways.

Inserting Background Music
You can insert a background music file when registering a new content item or 
configuring a content item.

Click  in the <Contents Setting> window to display the Open window and 
select a background music file. Author supports WAV, WMA, MID and MP3 file 
formats.

Inserting a Sound Element
There are 4 ways to insert a sound element.

In the File window, drag a music file from 
the local drive to the Stage window.

Tips

-- Audio Priority
For content containing Background Music, all 
Sound and Video elements are muted. 

In addition, you can play multiple sound and video 
elements at the same time
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Drag the Sound element from the Element 
window or a music file from the Favorites 
window and drop it on the Stage window.

You can import a sound content item 
registered to the server into the Stage 
window. The sound content item can be 
viewed in the Server Contents Window, 
and can dragged and added to the Stage 
window.

You can import a music file registered to 
a Template. Select Clip Art  in the 
Template window, select the “Sound” folder 
to view the music files registered to the 
template.

Tips

-- Synching Video and Sound Elements
You can play a video element as if a sound 
element is incorporated by playing the video and 
sound elements at the same time.

1) �Add Sound and Video elements to the content 
item and select both in the Timeline window by 
using the Ctrl key.

2) �Set the lengths of both elements to the same 
value.

3) �Change the <Mute> property of the Video 
element to <True>.
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Using the Appending Window
Some elements used when creating content contain sub folders or files. After 
adding such an element to a page, you have to append its sub folders or files.
You can attach a file or folder to an element using the Appending window. For 
example, when you have a video file with a caption file, the two files cannot be 
added to a page at the same time without using the Appending window. However, 
you can add the video file to the page, and then you can append the caption file to 
the video file as a sub element by using the Appending window.

The Appending Window Layout

1 2

3

4

1 Displays a preview and brief information for the file selected from the list of 
attachments.

2 Reloads the list of attachments. (Click this button if an additional item is missing from 
the list.)

3 Displays a list of appended files and folders.

4 Adds files or folders to or deletes files and folders from the list of attachments.

Adds a file to the list of attachments. When you click this icon, the Open 
window is displayed.
Adds a folder and its subcomponents to the list of attachments. When 
you click this icon, the Browse for Folder window is displayed.

Adds a new folder to the list of attachments.

Deletes the selected file or folder from the list of attachments.

Tips

-- You Can Use the Appending Window 
in These Cases :

1) �A <Flash> content item consists of multiple 
files in a folder.

2) �A video file contains a caption file.

3) �An HTML page consist of various links. (In this 
case, the HTML page contains folders and files.)
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Appending a File or Sub Folder to an Element
Select a file to be used as an element in the File window first and then drag it to 
the page you are creating. Alternatively, add an element in the Element window 
and select the main file.

Select the added element and add files and folders to it using the buttons at the 
bottom of the Appending window.

When you click a button, the Open window is displayed. Select a file or folder to 
append. Alternatively, create a new folder by clicking the Add Folder button.

If files and folders are added as shown in the picture above, it means they are 
appended to the added element.

Tips

-- Sub File Format
For the sub files included in an element, every file 
format is supported.
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Effects
You can insert various effects provided by Author for starting or ending elements or 
pages. For example, create between the elements or pages natural and impressive 
transition effects.

Note that you can insert both <In Effect> and <Out Effect> for elements, while 
you can only insert <In Effect> for pages. The types of effects for pages and 
elements are not the same.

Effect Types
You can insert various effects into the content created by Author or normal media 
files such as elements, templates, videos and images.

A total of ten effect type sets are available.

Recommended Access a set of effects popular among users.

3D 3D is a category for dynamic effects with a three-
dimensional feeling.

Alpha Alpha is a category for dynamic effects with 
masking images. 

Fade Fade is a category for effects that change opacity.

Fly On This is a 2D effect that represents various 
movements and actions.

PassThru In this effect, the element moves in a specified 
direction.

Push Push is a collection of effects in which morphing 
fragments move in a specified direction.

Reveal
In this effect, an element appears as a small-sized 
figure, gradually grows and returns to its original 
size and figure.

Special This option randomly plays various different 
effects.

Zoom In this effect, the element fragments, enlarge or 
shrink.

Tips

-- Applying an Effect
The effects that are applied to a page and the 
effects that are applied to an element are not the 
same.

3D and Fly On effects are not applicable to a 
page.
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Applying an Effect
You can insert various effects into a content item created using Author or normal 
media files such as elements, templates, videos and images.

Applying an Effect to an Element
There are 2 ways to apply an effect to an element.

The first method is dragging and dropping an effect from the Effect window to the 
start and end points of the intended track in the Timeline.

The second method is selecting an element into which you want to insert an effect and 
then selecting the <In Effect> or <Out Effect> in the Properties window.

If an <In Effect> was applied, it is indicated in yellow on the corresponding track; 
and if an <Out Effect> was applied, it is indicated in green on the corresponding 
track.

Out 
Effect

In 
Effect

After applying an <In Effect> or <Out Effect>, you can control its duration by 
dragging the edge of the effect bar horizontally.

Tips

-- Restrictions when applying effects
The range of effects that can be applied to 
content varies depending on the player type 
selected when content is created.



74

Applying an Effect to a Page
Only an <In Effect> can be inserted into a page. This can be done in 2 ways.

The first method is dragging and dropping the effect from the Effect window to the 
thumbnail for the page in the Pageline window.

The second method is inserting an effect in the Properties window of the page. Select 
a page and specify the effect in the Properties window.

Once the effect is applied to the page, the Effect icon is displayed in the Pageline 
window.

In 
Effect

Tips

-- Applying an Effect
Only an <In Effect> can be inserted into a page.
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Deleting an Effect
There are 2 ways to delete an effect.

The first method is selecting a page from the thumbnails in the Pageline window or a 
track from the timeline, right-clicking  and selecting <Delete In Effect>.

The second method is deselecting the effect in the Properties window. Select an 
element or page and select the “blank” option as the effect name in the Properties 
window.

Configuring the Element Properties
You can select an element containing an effect and configure the properties of the 
element in the Properties window. Normally, you can also specify the effect duration 
and direction. (However, Effect Direction may not be enabled for some effects.)

Tips

-- Direction of Effects
The direction of effects varies depending on 
the type of effect. The direction may be North, 
Northeast, East, Southeast, South, Southwest, 
West or Northwest.

You can only select the incoming effect direction 
or outgoing effect direction for an <In Effect> 
that supports the direction option.
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Previewing an Effect
The red triangle button at the top right of each effect icon in the Effect window is 
the effect preview button. Click it to preview the effect in the Stage Window without 
actually applying it to an element or a page.

To preview the effect of an Effect on the element only, select an element and click 
the Effect preview button. If you click the Effect preview button without clicking an 
element, you can preview the effect of an Effect on the page.

To cancel previewing the Effect, press the Esc key on the keyboard.

Tips

-- Preview

You can preview using the Preview button for 
the effect thumbnail. You can also preview all 
the elements displayed on the page by using the 
buttons at the bottom of the Timeline window.
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Examples of Applying Effects

Applying an Effect to an Element

The example below shows the "Erosion" <In Effect> applied to the "Circle" 
element. The direction is East and the duration is 3 seconds. If you increase the 
duration, the effect runs more slowly.

Applying an Effect to a Page

The example below shows the “WetWiper” <In Effect> applied to a page. The 
direction is East and the duration is 2 seconds. If you increase the duration, the 
effect runs more slowly.
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Event
Each element and page has events which can be triggered. Click the Event Setting 
button in the Properties window to apply a script to these events , which will dictate 
the movement of the elements or pages, There are 2 kinds of events: basic events 
and additional events.

Event Types

Basic Events

AM_EVT_KEY_DOWN The event is triggered when you press a key 
on the keyboard.

AM_EVT_OBJECT_START The event is triggered when an object 
starts.

AM_EVT_OBJECT_END The event is triggered when an object ends.

AM_EVT_OBJECT_TIME_
OUT

The event is triggered the moment playing 
an object is finished.

AM_EVT_CLICK The event is triggered when you click a 
mouse button.

AM_EVT_CURSOR_OVER
The event is triggered when the cursor 
moves over any element in the <Stage 
window>.

AM_EVT_CURSOR_OUT
The event is triggered when the cursor 
moves away from any element in the 
<Stage window>.

Additional Events Created by Adding Elements

AM_EVT_NEWS_RELOADED The event is triggered when the RSS of the 
RSS element is updated.

AM_EVT_WEATHER_
CHANGED

The event is triggered when the weather 
information for the Weather element is 
updated.

AM_EVT_TIMER The event is triggered by the Timer 
element.

AM_EVT_CHART_
CATEGORY_RAISED

The event is triggered by the Chart element. 
The event is triggered when the category of 
the Chart element is changed.

AM_EVT_TEXT_CHANGED    
An event occurs from a text element. If text 
in a text element changes, an event occurs 
in the changed element.

Tips

-- Event
An Event is any change that can occur in an 
element. The instructions which trigger specific 
actions in response to an event are in the form 
of a script.
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Applying an Event Script
Applying a script to an event between a page and element allows you to create 
more interactive and sophisticated content. The script provided by Author has been 
developed on the basis of Visual Basic Script (a script language for Windows). 
Creating a script is easy if you are familiar with Visual Basic Script. In addition, 
Author provides a Script Editor and a Script Wizard to make creating a script easier.

Script Editor
Script Editor provides various functions and helps you use them effectively. Using 
this tool, you can edit a script. Not only can you use all the functions provided by 
Author but also all the VB script commands. This tool is provided for advanced 
users.

Script Editor Screen Layout
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5

6

7

2

1

3

8

1 Shows the thumbnail image and name of the currently selected object (element and 
page).

2 If you select <User Function>, the list of user-defined functions are displayed. If you 
select <Supported Functions>, a tree showing the category or object providing the 
supported functions is displayed at the top and the list of functions provided by the 
category or object selected above is displayed at the bottom.

Adds a user function.

Deletes the function selected in the user function list.

3 You can select either <User Function> or <Supported Functions>. Depending on the 
selection, different function lists are displayed.

4 You can move between the function editing page and the event page.

5 If you select the <Edit> tab, the script editing page is displayed and if you select the 
<Event> tab, the event selection page is displayed where you can apply the script.

Redefines all the basic properties of the function.

Modifies the content of the function.

Caution

-- Applying an Event Script
To apply an event script, you should create an 
event script after selecting the element or page to 
which the event script will be applied. If you apply 
an event script to anything other than the element 
or page to which the event script will be applied, 
you will not get the desired result.

Tips

-- Script Editor
The Script Editor edits a script using all the 
functions provided by Author. This tool is intended 
for advanced users.

-- Script Wizard
The Script Wizard provides only some of the 
functions provided by Author and allows users 
unfamilar with VB Script to easily apply scripts. 
This tool is intended for normal users.
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6 Shows detailed information of the selected function.

7 If you select this option when you add a function that requires parameters, a helper that 
helps setting parameters appears.

8 Locks the Script Editor. If you click this button, the Script Editor is displayed at the top of 
the screen.

Using Script Editor

To launch Script Editor, set an event in the Properties window or click the  button 
on the toolbar.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Select an element in the Stage window you 
want to create a script for and click the  
button in the Properties window to open the 
Event window.
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Select an event from the Event window. 
Once you have selected an event, you 
must create a function for the event. Select 
<Edit...> from the drop-down menu on 
the right side of the event title to create a 
function. (If there is an existing function, 
the title of the function also appears in the 
drop-down menu.)
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After Script Editor appears, click the  
button at the bottom to create a function. 
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If you set up <Function> and 
<Parameters>, the function is defined 
in <Define Function>. After a function is 
created, click <OK>.

Tips

-- Parameters
A parameter is a message containing values 
necessary for the operations of functions. The 
results of functions are determined by the 
values of the entered or inputted parameters. In 
Author, “parameter” may also refer to variables. 
For example, in the function y = f(a+b), the 
parameters are a and b. If the function has no 
return value, you can set the parameter to a 
random value.

-- Parameter Attributes
If the value of a parameter is a text string, select 
String; if the value of the parameter is a number, 
select Number; and if the value of the parameter 
is “true” or “false,” select Boolean.
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You can now edit the created function. Click 
<Supported Functions> in the tab at the 
bottom left. Select an element from the 
Element tree.
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If you click the property or function to be 
used in the function list at the bottom left, 
a detailed description of the property or 
function is displayed.
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To add a function, double-click it. You can 
edit the function by entering the parameters 
referring to the description about the 
function near the bottom of the screen.
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Click <Save> at the top right to register the 
edited function to <User Function>.
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If you click the <Event> tab at the top, the 
event list is displayed.
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If you select an event to which the edited 
function will be applied and click <Apply>, 
<Parameter Helper> normally appears. 
Note that <Parameter Helper> only appears 
when the function to be applied has 
parameters. Configure the parameters and 
click <OK>.

Tips

-- Concept of a Function
A user function can be regarded as one script or 
set of functions or attributes provided by Author.

-- Parameter Helper
This helps you to create parameters easily. 
Parameter Helper, if selected at the bottom of the 
Script Editor window, will appear after you apply a 
script to an event.

When <Parameter Helper> appears as above, 
enter the parameters in int1 and int2. A result will 
be calculated using a function with the entered 
parameters.
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You can confirm that the script has been 
applied by checking the event in the 
Properties window.

Script Wizard
Script Wizard helps create scripts more easily. Even a novice user who does not 
know anything about VB Script can easily create and apply scripts. However, the 
Script Wizard only supports a small number of the functions provided by Author.

Using Script Wizard

To launch <Script Wizard>, set an event in the Properties window or click the  
button in the toolbar.
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Select an element you want to set a script 
for in the Stage window and click  in 
the Properties window to open the Event 
window.
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Select an event from the Event window. 
Once you select the event, you must create 
a function for the event. Select <Script 
Wizard> from the drop-down menu on 
the right side of the event title to create a 
function. (If there is an existing function, its 
title also appears in the drop-down menu.)
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After Script Wizard appears, select an event 
to apply a script to and click <Next>. 

Tips

-- Creating a Script
Creating a script is equivalent to writing a 
function. (which can consist of subfunctions). The 
functions created by users are related and can be 
connected to each other.
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Enter a name for the script and select 
an object to be added to <Supported 
Functions>. Provided functions vary 
depending on the category you selected 
from the drop down menu.
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Select a function to apply and click  to 
apply the function. If you select an applied 
function and click the  button, the 
applied function is removed from the list. If 
you have applied more than one function, 
you can change the execution order of the 
functions by using the  and  buttons.

Click <Next>.
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Select the page containing the element to 
which the selected script is to be applied 
and select the element name. 
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Enter the parameters necessary for the 
construction of the corresponding script 
according to the provided instructions, and 
then click <Next>.
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Confirm the construction of the script and 
click <Finish>.
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You can confirm that the script has been 
applied by checking the event in the 
<Properties> window.

Tips

-- Script Name
A script name cannot be used for more than one 
script. 

-- Execution Order of Functions
The higher the position of the applied function in 
the <Selected script> list, the earlier the function 
is performed.
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Configuring the Options
You can configure the overall settings required to create a content item such as the 
system settings, design settings, network settings and so on. To open the Option 
window, in the menu bar, click Setting > Option, the Option window appears.

Design
You can configure the content design and system settings.

Resolution
Sets the default resolution that will be applied 
when you create a new content item. The default 
resolution is initially set to 1366 X 768 pixels.

Default Display 
Option

Sets the content playing policy.
Sets the aspect ratio (<Original Size> / <Fit 
to Screen> / <Lock Aspect Ratio>) for playing 
content.

Page Sets the playback duration of a page. The default 
playback duration is 1 minute.

Element Sets the playback duration of an element. The 
default playback duration is 1 minute.

Working Directory
Sets the default directory for saving a finished 
content item or a content item being created and 
for opening a saved content item. 

Working Directory

You can save a content item being created or that has 
already been created or you can specify the directory 
to load a saved content item. Select the <Working 
Directory> checkbox to set a directory. You can 
specify a folder by clicking the Browse button .

Empty Temporary 
Folder

Author creates a temporary file saved to a temporary 
folder when a content item is being created to reduce 
unnecessary loading. Click the  button to delete 
the temporary folder.

Maximum number of 
Undo/Redo

Sets the maximum number of supported undo 
or redo commands when creating a content 
item. This setting is only applied after Author is 
restarted.

Auto Save

When you author a content item, you can use the 
auto save function. Select the <Auto Save Interval 
(Min)> checkbox to specify the auto save time. 
The content item being authored is autmatically 
saved at the specified interval.
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Server
You must configure the connection with the MagicInfo Server before you can 
publish a created content item.

Address Enter the IP address of the MagicInfo Server to 
connect to.

HTTP Port Enter the HTTP port of the MagicInfo Server to 
connect to.

FTP Port Enter the FTP port of the MagicInfo Server to 
connect to.

Login ID Enter the login ID for the MagicInfo Server.

Login Password Enter the password for the MagicInfo Server.

Script
Customize the Script Editor settings. 

Script Configuration Sets the interface of the Script Editor.

Font Customize the Script Editor settings. All fonts supported by 
Author are supported.

Size Sets the font size to be used when you write a script. 

Tab Size Sets the tab size to be used when you write a script. Tab 
generally means pressing the <Tab> button on the keyboard.

Item Select an item to which the text color and fill color are to be 
applied.

Text Color Select an item in <Item> and select the <Text color>.

Fill Color Select an item in <Item> and select the <Fill Color>.

Preview Displays a preview of the script configuration.



86

Log
If Author communicates with the server or packages a content item, the operation 
is recorded. The file containing the record is called a Log.

Log Level The amount of recorded data in the Log file is 
determined by the specified log level.

Communication Records to the Log file the operations that occurred while 
communicating with the MagicInfo Server.

Packaging Records to the Log file the operations that occurred while 
packaging a content item.

Upload Records to the Log file the operations that occurred while 
uploading content to the server.

Download Records to the Log file the operations that occurred while 
downloading content from the server.

General Logs the details of general tasks that take place while the 
authoring tool is used.
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Publish Content
You can publish a created content item directly to the MagicInfo Server, removable 
disk or local drive.

Publishing Content

Publishing to a local area
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In the menu bar, File > Publish or click  in the toolbar to open the <Publish Job> 
window.
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Set the <Location> item in the <Publish Job> window. Click  and select a disk drive 
to publish the content item to.
Click  to open the Browse for Folder window and  then select the folder you want to 
publish the content item to.
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Press the  button to publish the content.
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The progress is displayed and the published content item is saved in the folder 
specified in Step 

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

. 

Publishing to a local disk drive
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In the menu bar, click File > Publish or click  on the toolbar to open the <Publish 
Job> window.1
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Set the <Protocol> of the <Upload Target> to <Local>.
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Select the <Upload> option and select a local disk drive from the <Category> bar. To 
share the content item, select the <Share> option.
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Click  to publish the content.
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After publishing begins, check the status of the packaging and upload. When 
publishing is complete, the “Contents” and “Schedule” folders are automatically created 
and the content item is saved in a subfolder consisting of internal identifiers.

Tips

-- Packaging a Content Item
If you do not check the <Upload> checkbox, 
the content is not uploaded to the server but 
packaged in the <Location> directory at the top 
of the <Publish Job> window. The packaed file 
(.lfd) contains all the elements and configuration 
information used in the content item.

-- Publishing Locally
Publishes a content item being created to the local 
area set by the user. This is used to publish, move 
or store a content item.

-- Publishing to a Local Drive
Publishes a content item being created to the local 
disk drive set by the user. The content is saved 
in the “Contents” and “Schedule” folders that are 
automatically created on a storage device such as 
a removable disk and can be directly played on a 
MagicInfo Player.

-- Publishing to a MagicInfo Server
Publishes a content item being created to the 
currently connected MagicInfo Server. You can 
directly confirm the published content on the 
MagicInfo Server.
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Publishing to a MagicInfo Server
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In the menu bar, click File > Publish or click  in the toolbar to open the <Publish 
Job> window.1
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Set the <Protocol> of the <Upload Target> to HTTP(s) or FTP(s) and enter the IP 
address and port number (HTTP or FTP) of the MagicInfo Server you want to connect 
to.
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Enter the <Login> information including the login ID and password for the MagicInfo 
Server to which contents will be published. In the <Contents Name> field, enter the 
name of the content item to be displayed through the server
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Select the <Upload> option. If the MagicInfo Server is properly connected, the 
contents category for the MagicInfo Server appears in the <Category> field. Select a 
category to be uploaded. To share the content item, select the <Share> option.
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Click  to publish the content.
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After publishing begins, check the status of the packaging and upload. When 
publishing is complete, the MagicInfo Server window appears. Confirm that the content 
has been registered by Author.

Tips

-- HTTPS
Hypertext transfer protocol over secure sockets 
layer (HTTPS) is a web communication protocol, 
and unlike HTTP, encodes data before transmitting 
it. It is generally used to log in (through secure 
access) to websites that require user data 
protection, such as bank websites.

-- FTPS
File transfer protocol over secure sockets layer 
(FTPS) is a file transfer protocol, and unlike FTP, 
encodes data before transmitting it. It is generally 
used to safely exchange files between computers 
over the internet.

-- IP Address
If you have already entered the IP address for the 
MagicInfo Server in the <Option> window, the IP 
address is automatically entered in the <Address> 
field of the <Publish Job> window.

-- Login
If you have already entered the login ID and 
password for the MagicInfo Server in the 
<Option> window, both are automatically entered 
in the corresponding fields of the <Publish Job> 
window.
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Using Properties 03
MagicInfo Author

About Element Properties

Element Properties
Author supports various elements and each element has a different usage and 
properties. 
Elements can be divided into eight groups.

Widget
Access widget elements to display the clock and weather forecast.

Analog Clock

This element is used to display the current time as an analog clock.

∙∙ Clock
∙∙ Clock Image
∙∙ GMT

Clock

Clock Type Selects a type of clock to be imported.

White White Display the clock with a white background.

Grey Grey Display the clock with a gray background.

Select Clock Image Selects a file of a desired clock image. If this option is selected, 
the <Clock Image> item is enabled.

Clock Image

Clock Background 
Image

Selects a background image for the clock.

Hour Hand Image Selects an hour hand image for the clock.

Minute Hand Image Selects a minute hand image for the clock.

Second Hand Image Selects a second hand image for the clock.

Tips

-- Restrictions when applying elements
The range of elements that can be applied to 
content varies depending on the player type 
selected when content is created.

-- Clock Image
Clock Image is only enabled when <Clock Type> 
is set to <Select Clock Image>. 

Clock Image supports BMP, GIF, JPG and PNG file 
formats only. 
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GMT

Select GMT Selects GMT for the clock.

Daylight Saving Time
If Daylight Saving Time is applied to the GMT, 
this option determines whether to apply Daylight 
Saving Time.

Disable Daylight 
Saving Time Disables daylight saving time mode.

Enable Daylight 
Saving Time Enables daylight saving time mode.

Examples of using properties

Clock

Clock Type

You can select the appearance of the Analog Clock.

When the <Clock Type> is set to <White>. When the <Clock Type> is set to 
<Grey>.

Clock Image

This is activated when the <Clock Type> is set to <Select Clock Image>. You can 
add to the appearance of the clock with an image.

When the <Clock Image> is set to another 
image file.

Terminology

-- GMT (Greenwich Mean Time)
This is a world standard time. It refers to the time 
based upon the zero degree Greenwich Meridian 
(Prime Meridian) that crosses the Greenwich 
Observatory near London, England. 

-- Daylight Saving Time
Daylight saving time is the practice of advancing 
clocks by one hour ahead of local standard time 
to make the most of the longer lasting daylight in 
the summer.
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Digital Clock

This element is used to display the current time as a digital clock.

∙∙ Clock
∙∙ Font
∙∙ GMT

Clock

Time displaying 
format

Selects a time display format.

Text Color

Sets the color of the displayed time by entering an 
RGB value. Click the  button to open the Color 
window and set the color. Alternatively, you can 
specify the color by directly entering a value.

Background Color

Sets the background color of the clock by entering 
an RGB value. Click the  button to open the 
Color window and set the color. Alternatively, you 
can specify the color by directly entering a value.

Background Opacity
Sets the opacity for the background color of the 
clock. (Range: 0~100%)
0 means transparent while 100 means opaque.

Horizontal Align Aligns the displayed time horizontally.

Vertical Align Aligns the displayed time vertically.

Font

Font Name Selects a font for the time.

Font Size Changes the font size (1 to 512) for the time.

Italic Italicizes the font for the time.

Bold Makes the font for the time bold.

Underline Underlines the font for the time.

Strikeout Strikes a line through the font for the time.

GMT

Use Locale GMT Automatically enable GMT set on the user 
computer.

Select GMT Selects GMT for the clock.

Tips

-- Color Setting
In Author, colors can be set in the Color window. 
In the Color window, a color can be selected from 
the Basic Colors or created by directly entering 
RGB values.

-- Using custom fonts
You can add external fonts as custom fonts. Refer 
to “Adding Custom Font files” for further details. 
The availability of this function depends on the 
player type selected when content is created.
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Daylight Saving Time Determines whether to apply Daylight Saving 
Time.

Disable Daylight 
Saving Time Disables daylight saving time mode.

Enable Daylight 
Saving Time Enables daylight saving time mode.

Examples of using properties

Clock, Font

You can change the appearance of the Digital Clock using the <Clock> and <Font> 
properties.

You can create clocks with various 
appearances. 

An example of a Digital Clock used in a 
content item.

Hourly Forecast

Display hourly weather forecasts over the next five hours from the current time 
for the selected area. The GMT of the selected country and city is automatically 
applied.

∙∙ AccuWeather

AccuWeather

Country Select a country to display weather forecasts.

City Select a city of the selected country.

Language Select a language to apply to the element.

Tips

-- �Restrictions for Hourly Forecast 
elements
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.

Your computer must be connected to the 
Internet. The default image will appear if the 
computer is not connected to the Internet or 
weather information from AccuWeather cannot 
be received. 

-- AccuWeather
AccuWeather refers to a web service that pushes 
weather information as an image to the hourly 
weather forecast element.
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Background Select a background to display in the element.

Auto Automatically change the background color according to the 
weather.

City Image Automatically change the background to the representative 
image of the selected city.

Weather Image Automatically change the background image according to the 
weather.

Date and Time 
Format

Select a date and time format to display in the 
element.

Refresh Interval Set the interval to refresh weather information in 
the element.

Unit Set the temperature unit to apply to the element.

Celsius Set the temperature unit to Celsius.

Fahrenheit Set the temperature unit to Fahrenheit.

Examples of using properties

Use property items to display hourly weather forecasts for a desired area in various 
formats and backgrounds.

Hourly weather forecasts 
for Geneva, Switzerland in 
<Auto> background

Hourly weather forecasts 
for New York, U.S. in 
<City Image> background

Hourly weather forecasts 
for Hanoi, Vietnam in 
<Weather Image> 
background
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Today's Forecast

Display today's weather forecasts for the selected areas. 

∙∙ AccuWeather

AccuWeather

Country Select a country to display weather forecasts.

City Select a city of the selected country.

Language Select a language to apply to the element.

Background Select a background to display in the element.

Auto Automatically change the background color according to the 
weather.

City Image Automatically change the background to the representative 
image of the selected city.

Weather Image Automatically change the background image according to the 
weather.

Date and Time 
Format

Select a date and time format to display in the 
element.

Refresh Interval Set the interval to refresh weather information in 
the element.

Unit Set the temperature unit to apply to the element.

Celsius Set the temperature unit to Celsius.

Fahrenheit Set the temperature unit to Fahrenheit.

Examples of using properties

Use property items to display today's weather forecasts for desired areas in various 
formats and backgrounds.

Today's weather forecast 
for Geneva, Switzerland in 
<Auto> background

Today's weather forecast 
for New York, U.S. in 
<City Image> background

Today's weather forecast 
for Hanoi, Vietnam in 
<Weather Image> 
background

Tips

-- �Restrictions for Today's Forecast 
elements
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.

Your computer must be connected to the 
Internet. The default image will appear if the 
computer is not connected to the Internet or 
weather information from AccuWeather cannot 
be received.

-- AccuWeather
AccuWeather refers to a web service that pushes 
weather information as an image to the today's 
weather forecast element.
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7 Day Forecast

Display weekly weather forecasts for the selected areas.

∙∙ AccuWeather

AccuWeather

Country Select a country to display weather forecasts.

City Select a city of the selected country.

Language Select a language to apply to the element.

Date and Time 
Format

Select a date and time format to display in the 
element.

Refresh Interval Set the interval to refresh weather information in 
the element.

Unit Set the temperature unit to apply to the element.

Celsius Set the temperature unit to Celsius.

Fahrenheit Set the temperature unit to Fahrenheit.

Examples of using properties

Use property items to display weekly weather forecasts for a desired area in various 
formats.

Weekly weather for Geneva, Switzerland

Tips

-- �Restrictions for 7 Day Forecast 
elements
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.

Your computer must be connected to the 
Internet. The default image will appear if the 
computer is not connected to the Internet or 
weather information from AccuWeather cannot 
be received. 

-- AccuWeather
AccuWeather refers to a web service that pushes 
weather information as an image to the weekly 
weather forecast element.
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Multimedia
This category contains multimedia elements such as web cameras, images, videos, 
audio, etc.

Camera

This element is used to receive the image from the camera installed on the device 
(where a content item is being played) and display it in the content item. If a 
Camera element is added and previewed while a content item is being created on 
Author, the image from the camera installed on the PC where Author is running is 
received and displayed. If the content item is published and played on a monitor, 
the image from the camera on the monitor is displayed.

∙∙ Camera

Camera

Device number
Sets the device number of the installed camera. 
Numbers can be designated for each camera 
starting from 0.

Playmode
Sets the camera to either start recording when 
playing begins or start when triggered by an 
event.

Flash

This element is used to import a Flash file into the Stage window.
A Flash element is played with the Flash Viewer and not within the content item. 
If a Flash element is added, the Open window appears. Here you can select the 
Flash file you want to import.

∙∙ Flash

Flash

URL Enters a URL to play a Flash file on the web. Enter 
the URL of the Flash file.

Flash File Name
Shows the location of the Flash file.
If the location is changed, the Flash file is replaced 
with a file in the new location.

Window Mode Sets whether to play the Flash file in a window.
The playing speed is higher in window mode.

Access to input Sets whether to allow mouse input.

Caution

To properly preview or display Flash elements 
in thumbnail images in the Stage or Pageline 
window, the proper Flash player for that Flash file 
must be installed.

If a Flash element is added to the page and 
Window Mode is set to TRUE in Properties, the 
Flash element can be played at high speed but 
some effects cannot be applied.

If a Flash element is added to the page and 
Window Mode is set to FALSE in Properties, the 
Flash element is played at low speed but all 
effects can be applied.

Flash (when Window Mode is set to TRUE), 
Internet, Office, and PDF are Windows based 
elements and thus always displayed in the top 
layer of the screen even if their order or layer 
is lower than other elements. However, the 
order and layers are applicable to Window mode 
elements.
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Image

This element is used to import an image file into the Stage window.
If an Image element is added, the Open window appears. Here you can select the 
image file you want to import.

∙∙ Image
∙∙ Clipping
∙∙ DataSource

Image

Image File

Shows the location of the image file.
If the location is changed, the image file is 
replaced with a file in the new location. Click the 

 button to open the Open window and select a 
file.

Display Option Sets the display type for the image file.

Fit to Screen Stretches the image to fit the size of the selected element.

Lock Aspect Ratio Displays the image at its original aspect ratio within the selected 
element.

Tile Effect Tiles the image, maintaining its original size within the selected 
element.

Original Size Displays the image at its original size within the selected 
element.

Reversion Type
Selects a type of image reversion. The image is 
reversed depending on the selected reversion 
type.

No Reversion The image is not reversed.

Horizontal-Reflection Reverses the image horizontally.

Vertical-Reflection Reverses the image vertically.

Horizontal and 
vertical reflection Reverses the image horizontally and vertically.

Background Opacity
Specifies the opacity of the image. (Range: 
0~100%)
0 means transparent while 100 means opaque.
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Clipping

Original Width Shows the width of the original Image element. 
(Unit: pixels)

Original Height Shows the height of the original Image element. 
(Unit: pixels)

Left Clip Size Specifies the amount to be clipped from the left of 
the original Image element.

Right Clip Size Specifies the amount to be clipped from the right 
of the original Image element.

Top Clip Size Specifies the amount to be clipped from the top of 
the original Image element.

Bottom Clip Size Specifies the amount to be clipped from the 
bottom of the original Image element.

DataSource

DataSource Select a data module to apply to the element when 
a page contains multiple data modules.

Data Selection Specify information to import from the data 
source.

Keep Last Value Set the element status when an error such as a 
data receipt failure has occurred.

TRUE Set the element to display the current information.

FALSE Set the element to display the default information.

Data Transition Cycle

Enter an interval in seconds to switch to the next 
data item. If the data transition cycle is "0," the 
image element plays the first data item only. The 
text element will display all the data at the same 
time.

Data Synchronization 
ID

Set the ID to sync data.

Tips

-- Clipping
This function allows you to clip a particular section 
from a media or Image element.

Caution

-- Clipping
This option is only enabled when <Fill Mode> for 
the element is set to <Full size>.

-- Data source
This property can be configured after DataModule 
is enabled. In the design window, right-click and 
select DataModule Settings > Use DataModule to 
enable DataModule. 

Refer to “Using DataModule” for further details.
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Examples of using properties

Image

Background Opacity

You can make an image transparent.

When the <Background Opacity> is set to 
“100”

When the <Background Opacity> is set 
to “40”

<Button Mode>

You can create a button from an image. <Button Mode> consists of <2 Button 
Mode> and <3 Button Mode>. <2 Button Mode> consists of a basic image and 
an image that appears when the button is clicked. <3 Button Mode> consists of a 
basic image, an image that appears when the mouse cursor is over the button and 
an image that appears when the button is clicked. You have to prepare and apply a 
different image for each step.

The basic image. If <Button Mode> is set to <2 Button 
Mode> and the basic image is clicked, 
the image changes to another image.
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Media Slide

Configure a media slide. The basis to import media files is a folder. Put a media 
file(Image, Video, Flash, PDF and Office file) in a folder. Select the folder to play a 
slideshow of all the files contained in the folder.

∙∙ Media Slide

Media Slide

Folder
Sets the folder the media files for media slide will 
belong to. Click the  button to open the Browse 
for Folder window and select a folder.

Slide Time

Sets the time to play the media files constructing 
the media slideshow. If the time is set, all the 
media files are played for the specified period of 
time. Playback duration is set to at least 1 second 
or more.

Incoming Effect 
Name

You can select an effect to be applied when the 
element is played.

Incoming Effect 
Duration

Sets the duration of the Incoming Effect.

Incoming Effect 
Direction

Determines the direction of the Incoming Effect.

Input Source

This element is used to receive an external input signal and display it in the content 
item. The external input signal is sent directly to the monitor and always displayed 
on the screen with priority over other elements within the same area regardless of 
the display order or layer. The external input refers to an external device connected 
to the monitor where a content item is being played. 

∙∙ Input Source

Input Source

Input Type

Select an input source. Supported input sources 
include Component, AV, PC, DVI, BNC, HDMI, ATV, 
TV, MagicNet, DisplayPort, Plug In Module, Media 
and HDBT.

Tips

-- Entering the Time
Hours: Minutes: Seconds: 1/100 second  
Example: 10 hours, 2 minutes, 20.34 seconds = 
10:02:20.34

-- �Restrictions when using the input 
source function
Using the Input Source function is limited if 
you set the screen orientation to portrait when 
creating content.
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Channel Selects a channel when the input type is set to TV 
or DTV.

Minor Channel Selects a minor channel for DTV. This option is 
enabled when the input type is set to DTV. 

AirCable Selects a reception type (Cable or Air). This option 
is enabled when the input type is set to TV.

Sound Turns the audio of the input source on or off.

Sound

This element is used to import music files, such as MP3, WAV, WMA and MID, and 
play them in the content item.
Added sound elements only appear in the Timeline window and do not appear in 
the Stage window. If a Sound element is added, the Open window appears. Here 
you can select the sound file you want to import.

∙∙ Sound
∙∙ Play
∙∙ Clipping

Sound

Sound File
Sets the sound file to be played. Click the  
button to open the Open window and select a file. 
(Supported file format: Sound media file format)

Playback Option Sets the playing policy after the sound file is 
played once.

Play Once (Remove) Plays the file once.

Repeat Plays the file repeatedly.

Mute Turns the sound off while playing the sound file.

Volume
Sets the volume. (Range: 0~100)
This function may not be available depending on 
the player type selected when content is created.

Clipping

Original Duration Shows the duration of the original sound element.

Clipping Start Time Sets the time to start playing the sound element. 

Clipping End Time Sets the time to stop the sound element.

Tips

-- Channel
DTV refers to a TV that can receive digital 
broadcasts. You can enter the number of a 
broadcast channel from 0~9999. TV refers to a TV 
that can receive analog broadcasts. You can enter 
the number of broadcast channel from 2~99.

Tips

-- Clipping
This function allows you to clip a particular section 
from a media or Image element.

Just as you can clip a required area in an Image 
element, it is possible to clip a required sound 
element and play it.
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Text

This element is used to add a text box into the Stage window.
Text can be inserted into a text box and played in the content item.

∙∙ Text
∙∙ Font
∙∙ Play

Text

Text File

Sets the text file location that will be used to 
import text as a file. Click the  button to open 
the Open window and set the file. (Supported file 
format: *.TXT)

Text Background 
Color

Sets the background color (RGB) for the Text 
element. Click the  button to open the Color 
window and set the color. Alternatively, you can 
specify the color by directly entering a value.

Opacity
Selects a target to apply the opacity to. Select 
either <Text Background Opacity> or <Text 
Element Opacity>.

Text Background 
Opacity

Specifies the opacity of the text background. 
This option is enabled when <Text Background 
Opacity> is selected as <Select Transparency>. 
(Range: 0~100%)
0 means transparent while 100 means opaque.

Text Element Opacity

Sets the opacity of the text. This option is enabled 
when <Text Element Opacity> is selected as 
<Select Transparency>. The opacity is applied to 
both the text and background. (Range: 0~100%)
0 means transparent while 100 means opaque.

Horizontal Align Sets the horizontal text alignment type.
(Align Left/Align Center/Align Right)

Vertical Align Sets the vertical text alignment type.
(Align Top/Align Middle/Align Bottom)

Word Wrap
Displays the text fitted to the size of the element. 
The text longer than the width of the element is 
automatically wrapped to the next line.

Text Direction Sets the direction of the text display. (Horizontal/
Vertical)

Animation Direction
If the Animation Direction is set, the element is 
played as crawling captions. The text is displayed 
in the configured animation direction.

None Disables displaying crawling captions. The element will be 
played in normal form and not as captions.

Left to Right Sets the scrolling captions to move East.

Right to Left Sets the scrolling captions to move West.
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Top to Bottom Sets the scrolling captions to move South.

Bottom to Top Sets the scrolling captions to move North.

Speed of Text 
movement

Sets the speed of the scrolling captions. (Range: 
10~200)

DataSource

DataSource Select a data module to apply to the element when 
a page contains multiple data modules.

Data Selection Specify information to import from the data 
source.

Keep Last Value Set the element status when an error such as a 
data receipt failure has occurred.

TRUE Set the element to display the current information.

FALSE Set the element to display the default information.

Data Transition Cycle

Enter an interval in seconds to switch to the next 
data item. If the data transition cycle is "0," the 
image element plays the first data item only. The 
text element will display all the data at the same 
time.

Data Synchronization 
ID

Set the ID to sync data.

Using Text Elements

Text can be entered after adding a Text element to the Stage window and double-
clicking over the element. The entered text can be edited using the font toolbar.

Italic Underline

Bold Strikeout

Font

Custom 
Font

Text Color

Font Size

Font Size 
One Step 
Increase

Font Size 
One Step 
Decrease

Horizontal Text
Alignment

Vertical Text
Alignment

Caution

-- Data source
This property can be configured after DataModule 
is enabled. In the design window, right-click and 
select DataModule Settings > Use DataModule to 
enable DataModule. 

Refer to “Using DataModule” for further details.

Tips

-- Font Size One Step Increase
This button is used to increase the font size by 
one unit. It is only enabled in text string editing 
mode which is activated when a text element is 
selected and double-clicked.

-- Font Size One Step Decrease
This button is used to decrease the font size by 
one unit. It is only enabled in text string editing 
mode which is activated when a text element is 
selected and double-clicked.

-- Selecting a font
Select a font supported by Author. You can also 
select fonts from the font files that have been 
added using <Custom Font>.
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Adding Custom Font files

Add external font files as custom fonts.
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On the font toolbar, click the  button to display the Custom Font editor window. 1
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Click the <Add> button from the Custom Font editor window, then add an external 
font as a custom font. Font files with an extension .ttf or .ttc can only be added. To 
delete a custom font, select a font, then click the <Delete> button. 
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Added custom fonts can be viewed and selected from the font toolbar. 

Examples of using properties

Text

Text Background Color

Sets the background color of the text.

When the <Text Background Color> is set 
to “255;255;100”

When the <Text Background Color> is 
set to “255;100;100”

Tips

-- Restrictions for using Custom Font
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.
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Select Transparency

Select an object for which you wish to change its transparency. Select either <Text 
Background Opacity> or <Text Element Opacity> to activate the deactivated item 
just below.

When the <Text Background Color> is set 
to "255;100;100" and the <Text Background 
Opacity> is set to "100"

When the <Text Background Color> 
is set to "255;100;100" and the <Text 
Element Opacity> is set to "30"

Text Direction

You can set the direction of the text to <Horizontal> or <Vertical>. 

When the <Text Direction> is set to 
<Horizontal>

When the <Text Direction> is set to 
<Vertical>

Custom fonts

Add custom font files to access a wider variety of fonts.
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Video

This element is used to import a video file (AVI, MPG, MPEG, WMV, etc.) and play it 
in the content item.
If a Video element is added, the Open window appears. Here you can select the 
video file you want to import.

∙∙ Video
∙∙ Clipping
∙∙ Play

Video

Video File

Sets the file location that will be used to import 
a video file. Click the  button to open the Open 
window and select a file. (Supported file formats: 
Video media file formats)

Network URL Specify a video streaming address. You can enter 
an address to play streaming video.

Playback Option Sets the playing policy after the video file is played 
once.

Repeat Plays the file repeatedly.

Play Once (Pause at 
last state) Plays the file once and freezes in the last state.

Play Once (Remove) Plays the file once and removes the element.

Mute Turns the sound off while playing video.

Volume Sets the volume when playing video. (Range: 
0~100)

Window Mode
Sets whether to create separate window during 
play time or not. To be shown on top under 
window mode.

Background Opacity
Sets the opacity of the video element. (Range: 
0~100%)
0 means transparent while 100 means opaque.

Caution

To preview or display video elements in thumbnail 
images in the Stage or Pageline window properly, 
the proper codec for that video file must be 
installed.

Tips

-- Streaming Mode
When using a video element, the file selection 
mode and streaming mode cannot be used at the 
same time.

In streaming mode, only one video element 
and no other element can be played per page. 
Therefore, when using streaming mode, add only 
one video element per page.
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Clipping

Original Width Shows the width of the original video element. 
(Unit: pixels)

Original Height Shows the height of the original video element. 
(Unit: pixels)

Left Clip Size Specifies the amount to be clipped from the left of 
the original video element.

Right Clip Size Specifies the amount to be clipped from the right 
of the original video element.

Top Clip Size Specifies the amount to be clipped from the top of 
the original video element.

Bottom Clip Size Specifies the amount to be clipped from the 
bottom of the original video element.

Original Duration Shows the playing duration of the video element.

Clipping Start Time Sets the start time of the original video element.

Clipping End Time Sets the end time of the original video element.

Tips

-- Clipping
This function allows you to clip a particular section 
from a media or Image element.
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Shape
Various figures, such as 3D, arrows, lines and circular figures, are supported.

Common Properties

Margin

Left Shows the width of the internal left margin for the 
element as a percentage. (Range: 0~99%)

Right Shows the width of the internal right margin for 
the element as a percentage. (Range: 0~99%)

Top Shows the width of the internal top margin for the 
element as a percentage. (Range: 0~99%)

Bottom Shows the width of the internal bottom margin for 
the element as a percentage. (Range: 0~99%)

Line Style

Color

Sets the outline color for the element. Click the 
 button to open the Color window and set the 

color. Alternatively, you can specify the color by 
directly entering RGB values.

Weight Sets the outline thickness for the element. (Range: 
0~100 pixels)

Style Sets the outline style for the element. Click  and 
select an outline style.

Fill

Display Option Selects a fill type for the element.

Default Sets the fill type for the element to Default.

Linear Gradient Mode Sets the fill type for the element to Linear Gradient Mode.
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Rectangular Gradient 
Mode Sets the fill type for the element to Rectangular Gradient Mode.

Linear Gradient 
Direction

Sets the direction of the gradient. This option is 
enabled when <Display Option> is set to <Linear 
Gradient Mode>. Click  and select a direction.

Rectangular Gradient 
Direction

Sets the direction of the gradient. This option 
is enabled when <Display Option> is set to 
<Rectangular Gradient Mode>. Click  and select 
a direction.

Color

Sets the color to fill the element when <Display 
Option> is set to Default. Click the  button 
to open the Color window and set the color. 
Alternatively, you can specify the color by directly 
entering RGB values.

Gradient Start Color

Sets the gradient start color. This option is 
enabled when <Display Option> is set to <Linear 
Gradient Mode> or <Rectangular Gradient Mode>. 
Click the  button to open the Color window and 
set the color. Alternatively, you can specify the 
color by directly entering RGB values.

Gradient End Color

Sets the gradient end color. This option is enabled 
when <Display Option> is set to <Linear Gradient 
Mode> or <Rectangular Gradient Mode>. Click the 

 button to open the Color window and set the 
color. Alternatively, you can specify the color by 
directly entering RGB values.

Opacity
Specifies the fill opacity for the element. (Range: 
0~100%)
0 means transparent while 100 means opaque.

Fill Range

Selects an area of the element to be filled. If <Fill 
Inside> is selected, the inside of the element is 
filled, and if <Fill Outside> is selected, the outside 
of the element is filled.

Image File Fills the element with an image. Click the  
button to open the Open window and select a file.

Display Option Sets the fill type to fill the element with an image 
file.

Full size Stretches the image to fit the size of the selected element.

Lock Aspect Ratio Displays the image in its original aspect ratio within the selected 
element.

Tile Effect Tiles the image in its original size within the selected element.

Original Size Displays the image in its original size within the selected 
element.

Reversion Type Selects a type of image reversion. The image is 
reversed according to the selected reversion type.

None The image is not reversed.

Horizontal-Reflection Reverses the image horizontally.

Vertical-Reflection Reverses the image vertically.
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Horizontal and 
vertical reflection Reverses the image horizontally and vertically.

Transforming a Shape Element

Author provides various Shape elements. Each Shape element can have unique 
properties, which can be changed using the yellow handles which appear around 
the element. For example, the Arrow Callout element has yellow handles as shown 
below.

The shape of the figure can be transformed by dragging the handles. As the shape 
is transformed, the properties of the yellow handles change.

Examples of using properties

Position

Position X

Sets the horizontal start position (X coordinate) of the element. 

When <Position X> is set to “200” When <Position X> is set to “800”
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Position Y

Sets the vertical start position (Y coordinate) of the element. 

When <Position Y> is set to “600” When <Position Y> is set to “200”

Width

Sets the width of the element.

When the <Width> is set to “300” When the <Width> is set to “600”

Height

Determines the height of the element.

When the <Height> is set to “300” When the <Height> is set to “600”



112

Rotation

Sets the rotation angle of the element.

When the Rotation is set to “0” When the Rotation is set to “60”

Line Style

Color, Weight, Style

You can configure the <Line Style> of the element. 

When the <Line Style> is not configured When the <Color> of the <Line Style> 
is set to “255;128;255”, the <Weight> 
is “20”, and the <Style> is Dotted (the 
third of 5 line styles).

Fill

Fill Mode

Sets the <Fill Mode> of the element. <Fill Mode> provides the <Default>, <Linear 
Gradient Mode> and <Rectangular Gradient Mode> options.

When <Fill Mode> is set to <Default>. When <Fill Mode> is set to <Linear 
Gradient Mode>.
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When <Fill Mode> is set to <Rectangular 
Gradient Mode>.

Linear Gradient Direction

This is activated when <Fill Mode> is set to <Linear Gradient Mode>. Sets the 
direction in which to apply <Linear Gradient Mode>.

When the <Linear Gradient Direction> is set 
to <Vertical>

When the <Linear Gradient Direction> 
is set to <Horizontal>

When the <Linear Gradient Direction> is 
set to <Diagonal from Top Left to Bottom 
Right>

When the <Linear Gradient Direction> 
is set to <Diagonal from Top Right to 
Bottom Left>
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Rectangular Gradient Direction

This is activated when <Fill Mode> is set to <Rectangular Gradient Mode>. Sets 
the direction in which to apply <Rectangular Gradient Mode>.

When <Rectangular Gradient Direction> is 
set to <From Center>

When <Rectangular Gradient Direction> 
is set to <From Corner (Top Left)>

When <Rectangular Gradient Direction> is 
set to <From Corner (Top Right)>

When the <Rectangular Gradient 
Direction> is set to <From Corner 
(Bottom Left)>

When the <Rectangular Gradient Direction> 
is set to <From Corner (Bottom Right)>
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Color

Sets the color of the element when <Fill Mode> is set to <Default>.

When <Color> is the default color 
“79;129;189”

When <Color> is set to “255;128;0”

Note You can configure the color by directly entering the R, G and B values or selecting 
a color by clicking the  button.

Gradient Start Color, Gradient End Color

Sets the <Gradient Start Color> and <Gradient End Color> when <Fill Mode> is 
set to <Linear Gradient Mode> or <Rectangular Gradient Mode>.

When the <Gradient Start Color> is set to 
“0;0;255” and the <Gradient End Color> is 
set to “0;255;0”

When the <Gradient Start Color> is set 
to “128;64;64” and the <Gradient End 
Color> is set to “128;0;128”

Opacity

Sets the opacity of the <Color> of the element. The lower the value, the more 
transparent the element is.

When the <Opacity> is set to “100” When the <Opacity> is set to “40”
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Fill Range

Sets the <Fill Range> of the element. Select <Fill Inside> to fill the element with 
the color. Select <Fill Outside> to fill the exterior of the element with the color. The 
<Fill Range> property is useful for elements that do not completely fill the element 
area enclosed by the green rectangle in the figure below, such as a circle, rather 
than an element that completely fills the element area.

When the <Fill Range> is set to <Fill 
Inside>

When the <Fill Range> is set to <Fill 
Outside>

Image File

Fills an element with an image file.

When no <Image File> is selected When an <Image File> is selected

Display Option

This is activated when <Image File> is selected. Select the way to fill an element 
with the <Image File>.

When <Display Option> is set to <Fit to 
Screen>.

When <Display Option> is set to <Lock 
Aspect Ratio>.

Note

To delete the image file when the file is selected 
for an element, just remove the path of the image 
file.
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When <Display Option> is set to <Original 
Size>.

When <Display Option> is set to <Tile 
Effect>.

Reversion Type

This is activated when an <Image File> is selected. Reverses the image selected to 
fill the element with the image.

When the <Reversion Type> is set to 
<None>

When the <Reversion Type> is set to 
<Horizontal-Reflection>

When the <Reversion Type> is set to 
<Vertical-Reflection>

When the <Reversion Type> is set to 
<Horizontal and vertical reflection>
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Other
Access elements used to display webpages, documents, RSS and QR code.

Firefox

This element is used to import a web page and play it in the content item using 
the Firefox browser. If an element is added to the Stage window, the Open window 
appears where you can select a web page to be loaded. If you do not want to 
import a web page, click Cancel.

∙∙ Firefox

Firefox

URL Sets the web page address to use. 

File Select a web page file to be played. Click the  
button to open the Open window and select a file.

Office

This element is used to import MS Office files, such as MS Word, Excel or 
PowerPoint, into the Stage window.
An Office element is played with Office Viewer and not within the content item.
If an Office element is added, the Open window appears. Here you can select an 
Office file you want to import. A Word or Excel file is opened in full screen while a 
PowerPoint file is opened to fit the customized frame size of the element.

∙∙ Office

Office

Office File Name

Shows the location of an Office file. If the file 
location is changed, the Office file is replaced with 
a file in the new location. Click the  button to 
open the Open window. Select a file.

Caution

-- Firefox
To use <Firefox> elements, the <Firefox> web 
browser must be installed on the PC. To open a 
web page by entering a URL, the Internet must 
be connected.

-- Office Elements
To use Office elements, the viewer for the 
corresponding file format (Word, Excel or 
PowerPoint) must be installed.

Tips

Excel and Word elements which belong to Office 
elements are displayed in full screen and not 
within the element area.
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PDF

This element is used to import a PDF file into the Stage window.
A PDF element is played with PDF Viewer and not within the content item. 
If a PDF element is added, the Open window appears. Here you can select a PDF 
file you want to import.

∙∙ PDF

PDF

Document File

Shows the location of a PDF file. If the location is 
changed, the document is replaced with a file in 
the new location. Click the  button to open the 
Open window. Select a file.

Go to Page Enters the page number of the PDF file to be 
opened.

RSS

This element is used to display the RSS information received from RSS service 
providers, in the content item.

∙∙ Text
∙∙ RSS Setting
∙∙ Title
∙∙ Date
∙∙ Description

Text

Background Color

Sets the background color of the RSS element 
using Palette or RGB values. Click the  button 
to open the Color window and set the color. 
Alternatively, you can specify the color by directly 
entering a value.

Background Opacity
Specifies the opacity of the background. (Range: 
0~100%)
0 means transparent while 100 means opaque.

Animation Direction
If the Animation Direction is set, the element is 
played as crawling captions. The RSS information 
text crawls in the specified Animation Direction.

None Disables crawling captions. The element will be played normally, 
and not as captions.

Left to Right Sets the scrolling captions to move East.

Right to Left Sets the scrolling captions to move West.

Caution

-- PDF Elements
To preview PDF elements properly, the PDF viewer 
must be installed.

-- Go to Page
When you set <Go to Page>, the entered page 
number must be equal to or less than the total 
number of pages.

Terminology

-- RSS
RSS is a kind of transmissions protocol. While 
Http is the protocol to transmit HTML files, RSS is 
the protocol to transmit XML files. Using RSS, the 
information from a website can be viewed easily 
through an “RSS Reader” without connecting to 
the website. 

Tips

-- RSS Event
When you add an RSS element to the Stage 
window, the event script “AM_EVT_NEWS_
RELOADED” is automatically created in all 
elements of the Stage window.

�For more information on using the event script 
“AM_EVT_NEWS_RELOADED”, refer to the “Event” 
section.
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Top to Bottom Sets the scrolling captions to move South.

Bottom to Top Sets the scrolling captions to move North.

Speed of Text 
movement

Sets the speed of the scrolling captions. (Range: 
10~200)

RSS Setting

RSS Reload Duration Sets the RSS reload cycle in minutes. The RSS 
information will be updated at the specified time.

Display Option
Sets the RSS information to be shown during 
playback. (This may include the RSS title, date and 
summary.)

RSS URL Enters the URL of the RSS service provider.

Display Cycle

Sets the interval for displaying the RSS.
If a <Display Cycle> is set, short sentences are 
displayed at the specified interval, one after 
another, from among all the RSS information. 
(Unit: seconds)

Title

Font Name Changes the font (default: Arial) for the RSS title.

Font File Registers a new font file for displaying the RSS 
title (optional).

Font Size Changes the font (default: 35) for the RSS title 
(Range: 1~512)

Italic Sets whether to Italicize the RSS title (True) or 
not (False). (Optional)

Bold Sets whether to make the font for the RSS title 
bold (True) or not (False). (Optional)

Underline Sets whether to underline the RSS title (True) or 
not (False). (Optional)

Strikeout Sets whether to strike a line through the RSS title 
(True) or not (False). (Optional)

Text Color

Sets the font color for the RSS title using palette 
or RGB values. Click the  button to open the 
Color window and set the color. Alternatively, you 
can specify the color by directly entering a value.

Horizontal Align Sets the horizontal alignment type for the RSS title 
to either Align Left, Align Center or Align Right.

Tips

-- Using custom fonts
You can add external fonts as custom fonts. Refer 
to “Adding Custom Font files” for further details. 
The availability of this function depends on the 
player type selected when content is created.
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Date

Font Name Changes the font (default: Arial) for the RSS 
service date and time.

Font File Changes the font size (default: 35) for the RSS 
service date and time (optional).

Font Size
Changes the default font size (35) or already 
specified font size for the RSS service date and 
time. (Range: 1~512)

Italic
Sets whether to Italicizes the font for the RSS 
service date and time (True) or not (False). 
(Optional)

Bold
Sets whether to make the font for the RSS 
service date and time bold (True) or not (False). 
(Optional)

Underline
Sets whether to underline the font for the RSS 
service date and time (True) or not (False). 
(Optional)

Strikeout
Sets whether to strike a line through the font 
for the RSS service date and time (True) or not 
(False). (Optional)

Text Color

Sets the font color for the RSS service date and 
time using palette or RGB values. Click the  
button to open the Color window and set the 
color. Alternatively, you can specify the color by 
directly entering a value.

Horizontal Align
Sets the horizontal alignment type for the RSS 
service date and time to Align Left, Align Center or 
Align Right.

Tips

-- Using custom fonts
You can add external fonts as custom fonts. Refer 
to “Adding Custom Font files” for further details. 
The availability of this function depends on the 
player type selected when content is created.
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Description

Font Name Changes the font (default: Arial) for the main RSS 
text.

Font File Registers a new font file for displaying the main 
RSS text. (optional)

Font Size Changes the font size (default: 35) for the main 
RSS text. (Range: 1~512)

Italic Sets whether to Italicizes the font for the main 
RSS text (True) or not (False). (Optional)

Bold Sets whether to make the font for the main RSS 
text bold (True) or not (False). (Optional)

Underline Sets whether to underline the font for the main 
RSS text (True) or not (False). (Optional)

Strikeout Sets whether to strike a line through the font for 
the main RSS text (True) or not (False). (Optional)

Text Color

Sets the font color for the main RSS text using 
palette or RGB values. Click the  button to open 
the Color window and set the color. Alternatively, 
you can specify the color by directly entering a 
value.

Horizontal Align Sets the horizontal alignment type for the main 
RSS text to Align Left, Align Center or Align Right.

Tips

-- Using custom fonts
You can add external fonts as custom fonts. Refer 
to “Adding Custom Font files” for further details. 
The availability of this function depends on the 
player type selected when content is created.
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Examples of using properties

Text

Text Background Color

Sets the background color for the text that represents the information of the RSS 
element.

When the <Text Background Color> is the 
default text background color “255;255;255” 

When the <Text Background Color> is 
“174;174;0”

Text Background Opacity

Sets the background opacity of the text that represents the information of the RSS 
element.

When the <Text Background Opacity> is 
set to “100” and the RSS element and the 
Image element overlap

When the <Text Background Opacity> 
is set to “0” and the RSS element and 
the Image element overlap

Caption Direction

You can set the text representing the information of the RSS element as captions.

When the <Caption Direction> is set to <No 
Movement>.

Set the <Caption Direction> to either 
<Left to Right> or <Right to Left> to 
display the RSS information as captions 
in a horizontal direction.
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Set the <Caption Direction> to either <Top 
to Bottom> or <Bottom to Top> to display 
the RSS information as captions in a vertical 
direction.

Title, Date, Description

You can select various fonts for the RSS information by using the <Title>, <Date> 
and <Description> properties.
The <Title> determines the font for the title of the RSS information and the 
<Date> determines the font for the date of the RSS information . In addition, the 
<Description> determines the font for the description of the RSS information.

You can display RSS information in various formats.
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Web

This element is used to import a web page and play it in the content item using the 
Internet Explorer. If an element is added to the Stage window, the Open window 
appears where you can select an HTML file to be imported. If you do not want to 
import a webpage, click Cancel.

∙∙ Web

Web

URL Sets the URL address of the web page to be 
played.

FILE Selects a web page file to be played. Click the  
button to open the Open window and select a file.

Output Mode Set the mode to open a webpage.

Refresh Cycle Sets the refresh interval of a web page to be 
played. (Unit: minutes)

Access to input Sets whether to allow mouse and keyboard input 
when the web page is being played.

Show Scroll Controls the scrolling of Internet Explorer. The 
scrolling within a web page cannot be controlled.

Vertical Scroll Pos
Sets the position to scroll the web page vertically.
The content is played after vertically scrolling the 
web page by the specified unit. (Unit: pixels)

Horizontal Scroll Pos

Sets the position to scroll the web page 
horizontally.
The content is played after horizontally scrolling 
the web page by the specified unit. (Unit: pixels)

Caution

-- Web
To use Web elements, the Internet Explorer must 
be installed on the PC. To open a web page by 
entering a URL, the Internet must be connected.

Tips

-- Refresh Cycle
If you set the Refresh Cycle to 0, web pages are 
not refreshed and are played in the current state.
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DataModule

Create dynamic data using collected external data and apply it to content. Dynamic 
data changes with time. Refer to "Using DataModule" for details on how to create 
content using DataModule.

∙∙ Database Setting
∙∙ Table

Database Setting

Database Type Select a database type to use.

Database URL Enter the URL address of the database to use.

Database Port Enter the port number of the database to use.

Database Name Enter the name of the database to use.

Database Login ID Enter an ID to log onto the database.

Database Login 
Password

Enter a password to log onto the database.

Data Polling Interval Enter an interval in seconds to import data from 
the database.

Table

Table Selection Select a table containing desired information from 
the database. 

Query Create a query that will import desired information 
from the table.

Conversion Table Enter a string to convert imported text information 
into an image.

Tips

-- Restrictions for using DataModule
This feature may vary for your Player model.

-- Adding conversion images
After entering conversion table information, you 
can attach an image to apply to the created 
table. In the design window, right-click and select 
DataModule Settings > Attach File to attach an 
image to convert.
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DataLink Indicator

Display the DataLink function status in the indicator image.

∙∙ Indicator Image

Opacity

Set the opacity of the indicator image. (Range: 
0~100%)
0 makes the image completely transparent. 100 
makes the image completely opaque.

Indicator Type Set the indicator image type.

Default Use the indicator image Default provided by the program.

Type 1 Use the indicator image Type 1 provided by the program.

Type 2 Use the indicator image Type 2 provided by the program.

Select Indicator 
Image Set the indicator image to the image you want. 

Normal Working

Set the indicator image to display when the 
DataLink function is working properly. This option 
is only available when the indicator type is set to 
custom.

Not Connected to 
Server

Set the indicator image to display if unable to 
connect to the server when the DataLink function 
is in use. This option is only available when the 
indicator type is set to custom.

Display on Error Set the conditions to display the indicator image.

TRUE Set the indicator image to appear only when there is a problem 
with the DataLink function.

FALSE Set the indicator image to stay displayed all the time.

Tips

-- �Restrictions for DataLink Indicator 
elements
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.

Refer to  
"Using DataLink templates” for further details.
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Event Raiser
This category contains invisible elements related to events. An added element is 
displayed as a red time bar in the Timeline window and not displayed in the Stage 
window.

Timer

Triggers a timer event in a content item at a specified time interval.

∙∙ Timer

Timer

Elapse
Enters the interval of time for triggering the 
timer event. The unit is 1/1000 second. (To set 1 
second, enter 1000.)

Event Type Selects an interval policy for triggering a timer 
event.

Periodic Triggers a timer event continuously at every specified interval.

Just Once Triggers a timer event only once at a specified interval.

Play Mode Determines whether to start the timer 
immediately or when an event occurs.

Example of Utilizing the Timer

Repetitive Statement Used to execute a repetitive statement at a 
specified interval when writing a script.

Tips

-- Timer Event
When you add a timer element to the Stage 
window, the event script “AM_EVT_TIMER” is 
automatically created in all elements of the Stage 
window.

For more information on using the event script 
“AM_EVT_TIMER”, refer to the “Event” section.
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Tips

-- Restrictions for Sticker elements
Your MagicInfo Author version must be 3.1 or 
later.

This feature may vary for your Player model.

The range of stickers that can be used varies 
depending on the selected player type. 

-- Restrictions for entering text
Numbers or capital letters are only allowed for 
certain text sticker types.

Sticker
Use a variety of stickers. Stack several image stickers or enter messages in a text 
sticker.

Using image stickers

Image tickers use "sticker_number” as the naming format. Customize the sizes of 
stickers and arrange them where you want. Stack several stickers to create a new 
sticker.

Examples of using image stickers

Stack several image stickers to create new stickers.

Using text stickers

Text stickers use "sticker_tnumber” as the naming format. Customize the sizes of 
stickers and arrange them where you want. Stack several stickers to create a new 
sticker. You can also enter text in a sticker. The number of text input fields and 
the maximum number of letters vary depending on the design of the selected text 
sticker.

Text

Text 1 Specify text to fill in the first text input field.

Text 2 Specify text to fill in the second text input field.

Text 3 Specify text to fill in the third text input field.
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Examples of using text stickers

Enter text in a sticker. The number of text input fields and the maximum number of 
letters vary depending on the design of the selected text sticker.
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Tutorial on Content Creation 04
An Example of an Animation

A circle whose properties are changing
You can create an animation by applying different properties to a section created by adding Key-Frame to an element.
While the content item is playing, the properties of the circle element change continuously.
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Drag and drop the Circle element from the Shape category in the Element 
window to the Stage window.
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To configure an animation, check the <Show the current time elements only> 
checkbox in the Timeline window.

Note If the <Show the current time elements only> checkbox is not 
checked, a Key-Frame cannot be inserted.
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Right-click the upper part of the time bar and insert a Key-Frame to create an 
animation section of the element.1
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To make 20 changes during a duration of 20 seconds, add Key-Frames at 1 
second intervals. Twenty animation sections will be created.
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Now, select each Key-Frame and configure the properties. Since there are 20 
Key-Frames, you can set different properties 20 times.

Note You can change any property that can be configured using a 
number.

MagicInfo Author
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When the properties are applied, click the preview button ( ) to preview the content.
The Circle changes 20 times according to the properties applied to the Key-Frames.
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Moving the Element (Set Motion Path)
This content item will show a butterfly resting on a flower flies away after a while.
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Add the image of a flower to the Stage window and double-click over it to 
maximize the image.
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Insert a butterfly Flash into the Stage window.
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Insert Key-Frames in the Timeline window and specify a section the butterfly 
will move over.
(E.g. Add Key-Frames to the 4 and 20 second points.)
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Select the butterfly Flash, select the starting Key-Frame in the section and 
right-click to open the context menu. Click  <Motion Path> and <Set Motion 
Path>.
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With the left mouse button held down, draw the path the butterfly will move 
along.1
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When the Motion Path is set, click the preview button ( ) to preview the content item.
The butterfly will stay on the flower for 4 seconds and then fly for 16 seconds along the specified Motion Path.
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Changing Properties and Moving Elements
Let’s create a content item that shows falling snow flakes and after a short while, shows a WordArt element. The color of the 
WordArt element changes.
Set the playing time of the page to 2 minutes.
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Drag and drop the Rectangle element from the Shape category in the Element 
window to the Stage window. You are ready to design the background now. 
Double-click the Rectangle element to maximize it.

Configure the properties as follows: 
Set <Width> of <Line Style> to “0” and <Fill Mode> of <Fill> to <Linear 
Gradient Mode>.
Set <Gradient Start Color> to “0;0;160” and <Gradient End Color> to “0;0;0.”
Set <Duration> to “00;02;00.00.”1
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Drag and drop the Star element from the <Shape> category in the Element 
window to the Stage window in order to create a snow flake.

Configure the properties as follows: 
Set <Width> of <Line Style> to “0” and <Fill Color> of <Fill> to 
“255;255;255.”
Set <Star Width> to “80” and <Points> to <24-Pointed> in <Star> 
Properties.1
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Copy the snow flake several times to multiply them. Set the size and position 
of the snow flakes considering that they fall from top to bottom.
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Select a snowflake, right-click and select <Motion Path> and <Set Motion 
Path> to configure the path of the snow flake.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Draw the path for all the snow flakes.
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Apply a different Duration to each of the snowflakes in the Timeline window. 
Select all the snow flakes and set <Duration Policy> of <Play> to <Loop> in 
the Properties window.
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Drag and drop a WordArt effect from the WordArt category in the Element 
window to the Stage window.

Configure the properties as follows: 
Set <Fill Mode> of <Effect> to <Gradient> Mode and set <Gradient 
Direction> to <Horizontal>.
Set <Gradient Start Color> to “255;255;0” and <Gradient End Color> to 
“255;128;255.”
Set <Text Background Opacity> of <Text> to “0.”
Set <Start time> in <Play> to “00:00:05:00” and set <Duration> to 
“00:02:00:00.”
Set <Font Name> in <Font> to select the font you require.
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To let the WordArt appear more naturally, you can use some effects.
In the Effect window, insert the Dissolve effect of the Fly on category into the 
WordArt.
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Add several Key-Frames to create sections for various color changes of the 
WordArt. Add Key Frames at 1 second intervals starting from 8 second point 
when the effect is finished.

Note If the <Show the current time elements only> checkbox is not 
checked, a Key-Frame cannot be inserted.
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Now, select each Key-Frame and configure the properties. For color variations 
of the WordArt, apply different values to <Gradient Start Color> and 
<Gradient End Color> for each Key-Frame.
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When the Motion Path is set, click the preview button ( ) to preview the content item.
If the content item is played, snowflakes will begin to fall and after 5 seconds, the “Happy New Year~!!” message will be displayed. 
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Creating Content
This section describes the procedures for creating a content item.

(STEP 1) Start Creating a Content Item
There are 3 ways to start creating a content item.

In the menu bar, click File > New Content or click  in the toolbar to open a new page.

In the menu bar, click File > Open or click  in the toolbar to display the Open window. Select a finished content item or a content item 
being created to edit it.

Double-click a template from the template list that appears when <Template> is selected in the Template window and edit the displayed 
file.
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(STEP 2) Customize the Layout
Define the layout you think is best for conveniently creating content in Author.

(STEP 3) Add Elements
Add elements provided by Author such as Image, Video, Sound and Text to the Stage window. Elements that are not provided 
by Author can be added through the Template window and the File window.
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(STEP 4) Configure the Properties of the Element.
Configure the properties of the selected element in the Properties window. Select an element in the Stage window or select the 
track for the element in the Timeline window, then set the properties of the element.

(STEP 5) Arrange Elements
Arrange elements in the Stage window, and set the effect and playing time of the elements in the Timeline window.
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(STEP 6) Set Events
To set the event of the element, create a script in the Properties window.

(STEP 7) Insert a New Page
Add a page to the Pageline window and edit the page.

(STEP 8) Publish the content item
Publish the finished content item to the local disk drive or MagicInfo Server.
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Steps to create DataLink content
The DataLink feature allows you to collect and use data from external sources on your computer. Use the DataLink Template or 
DataModule option to create dynamic data using collected data as elements. Dynamic data changes with time.

Using DataLink Template

(STEP 1) Start Creating a Template
There are 2 ways to start creating a template.

In the menu bar, click File > New DataLink Template or click  in the toolbar to open a new page. This feature may vary for your Player 
model.

In the menu bar, click File > Open or click  in the toolbar to display the Open window. Select a finished content item or a content item 
being created to edit it.
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(STEP 2) Add Elements
Add elements provided by Author such as Image, Video, Sound and Text to the Stage window. Elements that are not provided 
by Author can be added through the Template and the File window.

(STEP 3) Configure a Datalink
Configure the Assign DataLink values set to True or False in the Properties tab or click  to configure it. DataLink can be used with 
media slide, video, image, and text elements.
A content file with elements that have DataLink applied becomes a DataLink template.
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(STEP 4) Configure a Datalink Condition
Configure values of DataLink in the Properties tab. 

General element properties

The following properties can be configured for general elements.

Data Transition Cycle

To apply the DataLink function, specify the transition interval between data elements. The next 
data element runs according to the specified transition interval. 
[Data Transition Cycle] can also be specified in the DataLink window.
If the data transition cycle is 0, the first data element is played for image, MediaSlide, Flash or 
tablet elements. For video and sound elements, all the files are played sequentially according to 
playback duration. Text and word art elements appear simultaneously.

Data Group Enable or disable the mode for elements under a group to share DataLink data.

Data Synchronization Display DataLink data under a group simultaneously on an LFD.

Keep Last Value
Configure settings to run elements in the occurrence of an error such as a data reception error.
Depending on the settings, elements can continue to display the current information or display the 
default information assigned to the elements.

Inner DataLink 
Description

Configure the specification that shows a data type when delivering DataLink information to the 
inside of elements. This property is only available for Flash elements that have DataLink applied.

Page properties

The following properties can be configured when a page is selected from the page line.

Clear DataLink Item Enable or disable the mode to reset data of all elements under a data group at the data transition 
interval.

Data Change Target Enable or disable the mode to play all elements under a data group after data is changed.
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(STEP 5) Publish Content
Publish created content to MagicInfo Server or a local drive. Save the LFD or LFT as an another name to use the LFD and LFT or 
vice-versa.
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Using DataModule

(STEP1) Creating content
Select File > New Contents on the menu bar, then click the   icon on the toolbar. A new page will appear after you finish 
configuring content settings. This feature may vary for your Player model.

(STEP2) Adding elements
Add elements in the design window. Elements can include images and text provided by Author. Elements can be added using the 
template and file windows. This excludes elements provided by Author.
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(STEP3) Enabling DataModule
In the design window, right-click and select DataModule Settings > Use DataModule to enable DataModule. 

(STEP4) Adding DataModule elements
Add DataModule elements in the design window. DataModule elements are grouped to Other in the design window. Added 
DataModule elements can be viewed from Timeline. They are not displayed in the design window.

￼



148

(STEP5) Configuring DataModule properties
Select DataModule from the timeline, then configure the required information using the Properties window.

Database Setting

Database Type Select a database type to use.

Database URL Enter the URL address of the database to use.

Database Port Enter the port number of the database to use.

Database Name Enter the name of the database to use.

Database Login ID Enter an ID to log onto the database.

Database Login 
Password

Enter a password to log onto the database.

Data Polling Interval Enter an interval in seconds to import data from the database.

Table

Table Selection Select a table containing desired information from the database.

Query Create a query that will import desired information from the table.

Conversion Table

Enter a string to convert imported text information into an image.

Note After entering conversion table information, you can attach an image to apply to the created table. 
In the design window, right-click and select DataModule Settings > Attach File to attach an image 
to convert.
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(STEP6) Configuring DataModule information for elements
Configure DataModule information for each element using the properties window. Elements that can use DataModule include 
image and text elements. 

DataSource

DataSource Select a data module to apply to the element when a page contains multiple data modules.

Data Selection Specify information to import from the data source.

Keep Last Value Set the element status when an error such as a data receipt failure has occurred.

TRUE Set the element to display the current information.

FALSE Set the element to display the default information.

Data Transition Cycle
Enter an interval in seconds to switch to the next data item. If the data transition cycle is "0," 
the image element plays the first data item only. The text element will display all the data at the 
same time.

Data Synchronization 
ID

Set the ID to sync data.

(STEP7) Sending content
Send created content to a local drive or MagicInfo Server. Save content as another name to convert LFD content into LFT 
content or vice versa.
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System Setup for Live Streaming 
Use the Network URL feature in the video element to transfer and play a video being taken in real-time.
Broadcast the original file (encoded through Microsoft Windows Media Encoder 9 or Microsoft Expression Encoder) over the 
Windows Media Server and play the file on a MagicInfo Player.

Note Live streaming refers to real-time playback of data (music, videos, etc.) being transmitted to a client.

Live streaming Mechanism
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Devices Required for Live streaming

Encoding Machine

Encoding Machine is equipped with a video capture card and can be connected to a video camera.

Note To use Encoding Machine, an encoder program such as Microsoft Windows Media Encoder 9 or 
Microsoft Expression Encoder must be installed on the Encoding Machine.

Publishing Point

Publishing Point refers to a server where encoded media files are published.  Microsoft Windows 
Media Server can be used as the Publishing Point. 

Note Microsoft Windows Media Server is designed to stream Windows Media-based content. It is 
installed in the Windows Server OS group.
Windows Server 2003 contains Windows Media Service by default. Windows Server 2008R2 
requires Windows Media Service to be downloaded and installed separately.

MagicInfo Player Add a streaming video by entering the network URL address in Author. The streaming video must 
be sent from the server. You can play the video on MagicInfo Player.

Live streaming Process
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Video input from your video camera is received through the video capture card.
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The received video input is encoded as a Windows media file by the encoder program.
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The encoded media file is published by the server.
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The published streaming file is played on a MagicInfo Player.

Playing Streaming Files on a MagicInfo Player
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In the Design window of Author, drag and add the Video element to the Stage window.
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Enter the network URL address in the Network URL input field of the properties window in the format: “mms IP 
address/Publishing Point.”  Network URL supports the following formats: MMS, HTTP, HLS, RTP and RTSP. Supported 
formats can vary depending on the player type selected when content is created.
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Publish the Video element to the LFD where the MagicInfo Player is installed and play the streaming element.

Note For further details on live streaming, go to https://v3.samsunggsbn.com and refer to the technical guide.
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Scripting Guide 05
Script Writing Guide

One of the most powerful and important features of Author is the scripting engine.
Author scripting is based on the VBScript engine. You can use all the general VBScript commands.
Scripts enable using element events in various conditions and creating interactive contents.
This chapter describes the concepts and directions for use of the functions provided by Author.

Important Concepts in Scripting
There are important concepts you need to understand before scripting.

Script Wizard and Script Editor

Author provides a Script Wizard for users to easily create a script. Script Wizard shows the currently applicable 
function as a sentence so that users can use the script more freely. In addition, Author provides a Script Editor 
for advanced users who want to create more sophisticated and powerful scripts without using the Script Wizard.

Using the Script Wizard
Script Wizard is a scripting tool that shows scripts as sentences so that users can use scripts more easily by selecting one of the suggested 
sentences. You can use only some of the functions provided by Author.

Using the Script Editor
Script Editor enables users to create their own scripts. This scripting guide describes the procedures to create scripts using the Script Editor.

Note For information about the procedures to use the Script Wizard and Script Editor, refer to the “Events" section of this manual.

Users can use either a global or local script function.

If a global function is defined, the function is saved in Author and exists until deleted, and can be called from any 
content item. If a local function is defined, the function is saved in a content item and can only be called from 
the content item.

A script has various variables.

Variables are very important in scripting. Variables make changing values simple and enable reusing values. 
Author provides a Parameter Helper so that users can assign parameters more easily.

A script is a set of commands that generates an event.

For the types of events, refer to the “Events” section of this manual. Scripts are created for events so that 
the events are actually performed. For example, “AM_EVT_CLICK” is an event that is triggered when the 
corresponding element is clicked. If you have created a script that shows the “HELLO” message in a message 
box, if the element is clicked, the script is performed showing the “HELLO” message box.

MagicInfo Author
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Variables
Variables are very important in scripting. Variables make changing values simple and enable reusing values. In addition, variables 
make calling values easier.

An example of using variables

A variable called “a” with a value of 10 can be represented as follows:

a = 10

Now, let's see how you can use this variable.
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Add a blank Text element to the page.1
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Select the Text element and create a script for the “AM_EVT_CLICK” event.

a = “10”
Self.SetText (a)
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If you click the Text element, "10" is displayed in the Text element.

If “a” is declared as “10”, the variable “a” keeps the value of 10 until it is declared again.

The following consists of examples of simple variable use.

Script1

a = 10
a = a + 20
Self.SetText (a)

Since 20 is added to variable a which has the value 10, the result is 30, and the value displayed in the Text element would be 30.

Script2

a = 10
b = a
Self.SetText (b)

The result of the script above will be displayed as “10” because the syntax “b=a” assigned the value of “a” to “b.”

Scope of Variables
There are global and local variables.

Global Variables

The default type of variable in Author is a local variable. To create a global variable, you have to declare the variable as a global 
variable by calling a function. At this time, note that a global variable should be referred to by calling a function. The function 
used to declare a global variable is “SetGlobalVar” and the function used to retrieve a declared global variable is “GetGlobalVar”.

The following is a simple example of using a global variable.
Add a blank Text element to the page and select the page. Start the page and declare a global variable at the same time.
You can edit a function after defining the function (the function name is “savevalue” and the function parameter is dummy or 
none). Select “SetGlobalVar” from the function list of the “Contents” of Supported Functions. Modify the displayed function to 
Call Contents.SetGlobalVar(“x”, “hello”). Description at the bottom shows that “x” is the variable name and “Hello” is the variable 
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value. Click Save to create the “savevalue” function in the list of User Function. Select the created “savevalue” function, click the 
Event tab on the right side of the Edit tab, select “AM_EVT_OBJECT_START” and click Apply. Exit the Script Editor.
 Then retrieve the global variable declared above. Select the Text element that was added first and make it dipslay the value of 
the global variable when the corresponding text is clicked.
You can edit a function after defining the function (the function name is “showvalue” and the function parameter is dummy or 
none). Select “SetGlobalVar” from the function list of the “Contents” of Supported Functions. The Parameter Helper appears. 
Enter the name of the variable declared above, “x”, as the parameter. Then, the function is entered as Contents.GetGlobalVar(x). 
After retrieving the global variable, let's display the value of the global variable. Enter “a = Contents.GetGlobalVar(x)” to specify 
the return value of the global variable corresponding to the variable “a.” Import “a” to the Text element. Select “SetText” from 
the list of functions in “Contents-Page1-text”. Modifiy the displayed function to “Contents.GetPage(“Page1”).GetElement(“Text”).
SetText(a)”. This means that the previously retrieved global variable “x” will be displayed in the text element. Click Save to create 
the “showvalue” function in the list of User Function. Select the created “showvalue” function, check the “AM_EVT_CLICK” 
checkbox in the Event tab and click Apply. Exit the Script Editor.
Play the content item and click the Text element. The value of the global variable “x” declared in “Page1” as “Hello” is displayed 
in the Text element.

Local Variables

A global variable maintains its value in the content item. However, a local variable can only be used within a function that is 
currently being created. Unless the “SetGlobalVar” and “GetGlobalVar” functions described above are used, all variables are 
regarded as local variables.

Variable Names
A variable name cannot start with a number and consists of alphanumeric characters and underscores except for some reserved 
words.

Examples of valid variable names:

a, strName, _My_Variable, data1, data_1_23, index, bReset, nCount

Examples of invalid variable names:

1, 1data, %MyValue%, $strData, for, if, _FirstName+LastName_

Reserved Words

and, break, do, else, elseif, end, false, for, function, if, in,local, not, or, repeat, return, table, then, true, until, while

Type
The type of variables in Author script language is formed dynamically. The type of variable is not explicitly declared, but is 
implicitly determined by the context where the format is used.
This means that you do not need to declare the type of the variable before using it. For example, to use a number in C++, you 
have to declare the type of variable and assign a value to the variable.

int a;
a = 10;

The example of C++ above declares “a” as an integer type and assigns “10” to the variable.

In summary, users can use variables without declaring their types in Author. Variables do not have actual types. Instead, the 
type is determined by the value. For example, the “a = 10” statement automatically creates a variable called “a” and assigns 
“10” to the variable. Even if a number is assigned to the variable, the type of variable is not fixed. This means that the value of 
“a” can be changed to a value of a different type such as “a = Hello”. This statement changes the number “10” saved in “a” to a 
string “hello”. In fact, the type of string is not important. The variable a saves what the user assigns regardless of the type of the 
value.
Author provides the Number, String and Boolean variable types. Read below to learn more about the three types of variables.
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Number

Number is a numeric value. The numeric type represents a floating type value. This formally means a double precision floating 
point number. The following are examples of valid numbers.
4, 0.4, 0.345, 4.57e-3, 0.3e12

String

A String is a sequential arrangement of characters. For example, “lee2” consists of 4 characters, starting with “l” and ending with 
“2”. The value in a String type should be enclosed by quotation marks (“”). In addition, the String type value can have various 
lengths. It can consist of one character, one word, one sentence or more. Approximately up to 2 billion characters are supported. 
The important point when you use a String type is that the Number and String types are automatically converted. Whenever a 
numeric operation is applied to a string, the Author’s scripting engine tries to convert the string into a number. Of course, the 
string can only be converted into a number when the string contains something that can be interpreted as a number.
For example,

The result of a = “10” + 1 is 11 and
the result of b = “33” * 2 is 66.

However, the example below will show a different result.

The result of a = “10+1” is string 10+1 and 
b = “hello” + 1 will cause an error. The reason is that “hello” cannot be converted into a number.

Boolean

The Boolean type variable may have a value of either true or false. Boolean type variables can be used for logical operations that 
have true or false as a result.

Assume that a logical operation is given as follows:

a = true
b = false
if (a or b) then
(Create the script to be executed, here.)
End

At this time, the condition is created by the true or false result.

Parameters
A parameter is a messenger that delivers the values necessary for the function operations. The result of the functions is 
determined by the values of the entered parameters. For example, in the function y = f(a+b), the parameters refer to a and b. If 
the function does not have a return value, you can set the parameter to a random value.

Parameter Attributes

For parameters, you have to declare their types unlike for variables. Parameters support the Number, String and Boolean types 
just like for variables.
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Operators
An operator is a unit of code that performs a calculation in one or more code elements that returns a value. These operations 
include arithmetic operations such as additions and multiplications, concatenation operations that combine two strings into one, 
comparison operations that determine the bigger of two values, and logical operations that check if both operations are true.

Arithmetic Operators
Arithmetic operators are used to perform various familiar arithmetic operations including the calculation of values represented by 
a variable, expression, function and attribute call.

Operators Descriptions
+ Addition
- Subtraction
* Multiplication
/ Division
% Modulo
^ Power

Comparison Operator
The comparison operator compares two expressions and returns a Boolean value representing the comparison result. There are 
operators that compare numbers, strings and objects.

Operators Descriptions
< Less
> Greater

<= Equal to or less
>= Equal to or greater
= Equal to

<> Not equal to

Concatenation Operators
Concatenation operators join multiple strings into one. The “+” and “&” connection operators are provided and both perform 
basic concatenation operations as shown by the example below.

x = abc
y = def
z = x & y or z = x + y

The result is z = abcdef. Here, the “&” and “+” operators are used as operators that merge strings.
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Assignment Operators
The Assignment statement performs the assignment operation. The value on the right side of the operator is assigned to the 
variable on the left side of the operator.

Operators Descriptions
= Assign

+= Add and then assign

-= Subtract and then assign
*= Multiply and then assign
/= Divide and then assign (float type)
^= Raise to the power and then assign
&= Merge strings and then assign
\= Divide and then assign (integer type)

Logical Operators
Compares boolean expressions and returns a boolean result. The And, Or and Xor operators require two operands. The 
Not operator performs a logical negation operation for a boolean expression to return the negative value of the calculated 
expression. For example, if the result of the operand expression is true, the result of the Not operation becomes false because 
the Not operator negates the result. If the result of the operand expression is false, the result of the Not operation becomes 
true.

Operators Descriptions
And Logical and (True only when both of the two operands are true)
Or Logical or (True when any of the two operands are true)
Xor Logical exclusive (True only when one of the two operands is true)
Not Logical negative (False when the operand expression is true)

Operator Priorities
The operator priority refers to the order of operators when there are multiple operators in an expression. The arithmetic and 
concatenation operators have the following priorities and have priority over the comparison and logical operators. Comparison 
operators have a higher priority than logical operators and a lower priority than arithmetic and concatenation operators. All the 
comparison operators have the same priority. That is, these operators are evaluated from left to right sequentially. Arithmetic, 
concatenation, logical and bitwise operators are calculated in the following order.

Category Priority Operator

Arithmetic Operators

1 Power Operator (^)
2 Negative Operator  (-)
3 Multiply and Divide Operators (*,/)
4 Integer Divide Operator (\)
5 Add and Subtract Operators (+, -), String Concatenation Operator (+)
6 String Concatenation Operator (&)

Comparison Operator

7 =
8 <>
9 <
10 >
11 <=
12 >=

Logical Operators

13 Not
14 And
15 Or
16 Xor

Using Syntax
The most frequently used script syntax consists of the conditional and loop statements. Here is some information about 
conditional and loop statements.

Conditional Statement (If...Then...else)
Performs a statement or a group of statements when a condition is met.
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If condition Then statement Else elsestatements  

Alternatively, the block statement syntax below can also be used. 

If condition Then 
          statements
ElseIf condition-n Then 
          elseifstatements . . .
Else 
          elsestatements
End If

The If...Then...Else  statement consists of the following elements.
Element Descriptions
condition One or both of the following types of expressions. 

A numeric or string expression evaluated to True or False. If the condition is Null, it is regarded 
as False. 

An expression in the format of "TypeOf object name Is object type" . The object name is a 
reference to a specific object. The object type is the type of the specific valid object type. If 
the object name is the type specified with the object type, the expression is evaluated to True, 
otherwise it is False.

Statements One or more statements delimited by colons. These are performed when the condition is True.

condition-n Same as for a condition.
elseifstatements One or more statements to be performed when the associated condition-n is True.
elsestatements One or more statements to be performed when the previous condition or condition-n is not 

True.

Note If you use the first syntax which has a single line, you can perform a conditional check in a short and simple way. However, the 
second syntax which is block type provides more structures and flexibility and is easier to read, manage and debug, compared with 
the single line syntax. 
In a single line If...Then statement, multiple statements can be performed when the condition is met. However, in this case, they 
must be placed on the same single line delimited by colons, as shown in the figure below. 
If A > 10 Then A = A + 1 : B = B + A : C = C + B

When the second If block statement is performed, the condition is tested first. If the condition is evaluated as True, the statement 
following the Then is performed. In this case, if the condition is False, and there are ElseIf statements, perform the statements of 
the corresponding ElseIf. 

If a condition is evaluated as True, the statement below the corresponding Then keyword is performed. If none of the ElseIf 
clauses are True or if there are no ElseIf keywords, the statements following the Else keyword are performed. After performing the 
statements below the Then or Else keyword, the statement below the End If keyword is performed. 

Both the Else and ElseIf clauses are optional clauses. Within an If block statement, you can use as many ElseIf statements as 
required, but there can be no code following the Else keyword on the same line. A If block statement can be nested. That is, it can 
include another If block statement within itself. 

The clause following the Then keyword is examined to determine whether it is an If block statement or not. If a statement which is 
not a comment follows the Then keyword on the same line, it is regarded to be a single line If statement. 

The first line of an If block statement must start with the If keyword and the conditional statement and the last line must end with 
the End If statement.

Loop Statement (For…Next)
Performs a group of statements the specified number of times repeatedly.

For counter = start To end Step step 
      statements
      Exit For 
      statements
Next
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The For...Next statement consists of the following elements.
Element Descriptions
counter This numeric variable is used as a loop counter and cannot be an array or custom type element. 

start The start value of the counter.

end The end value of the counter.
step Sets by how much the counter is incremented or decremented each time the loop is repeated. If 

the value is not specified, the step is set to 1 by default.
statements There are one or more statements between the For and Next to be executed as many times as 

the specified count.

Note The step element can be a positive or negative number. The step element determines when the loop is executed, as described in 
the table below. 

Value The loop is executed if
A positive number or Zero (0) counter <= end
Negative number counter >= end

Once the loop is started and all the statements in the loop are executed, the step is added to the counter. At this time, the same 
test is performed as when the first loop was executed. Then, according to the test result, either the loop is executed again or the 
loop is exited and the statement following the Next statement is executed. 
If the counter value is changed while the loop is being executed and not after the loop is iterated, it can be very difficult to read 
or modify the code. 

The Exit For statement can only be used within the For Each...Next or For...Next control structure in order to provide a way to 
exit a loop. You can place multiple Exit For statements in any place within a loop. The Exit For statement is frequently used when 
calculating a conditional statement, such as the If...Then statement, and transfers control to the statement immediately following 
the Next statement. 

A For...Next loop can be nested in another For...Next loop. The counter variable must be unique across all the loops. The following 
shows an example where the  For...Next loops are nested correctly. 

    For I = 1 To 10 
          For J = 1 To 10 
                For K = 1 To 10
                . . . 
                Next 
          Next
    Next
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Function Data
This section provides a description of the functions used in the scripts introduced in the "Events" section and their application 
examples.

Script Functions for the Contents Object

GetPage Parameter string

Example Contents.GetPage(“PageName”)
Returns the dispatch interface of the page called PageName.

GetGlobalPage Parameter string

Example Contents.GetGlobalPage()
Returns the global page object of the current content item.

MovePage Parameter string

Example Contents.MovePage(“PageName”)
Moves the current page to the page called PageName.

GetFirstPage Parameter string

Example Contents.GetFirstPage()
Returns the dispatch interface of the first page of the current content item.

GetLastPage Parameter string

Example Contents.GetLastPage()
Returns the dispatch interface of the last page of the current content item.

GetGlobalVar Parameter string

Example Contents.GetGlobalVar(strGlobalVar)
Imports the global variable declared as strGlobalVar into the current content item.

SetGlobalVar Parameter string, string

Example Call Contents.SetGlobalVar(strGlobalVar, strValue)
Sets a global variable called strGlobalVar with the value strValue for the current content item.

ResolutionWidth Parameter string

Example Contents.ResolutionWidth
Returns the width resolution of the content item.

ResolutionHeight Parameter string

Example Contents.ResolutionHeight
Returns the height resolution of the content item.

Path Parameter string

Example Contents.Path
Represents the file location of the currently opened content.
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Script functions for the Page Object

GetElement Parameter string

Example Contents.GetPage(“Page1”).GetElement(“elem1”)
Returns the dispatch interface of the element elem1 owned by page Page1.

GetGlobalElement Parameter string

Example Contents.GetPage(“Page1”).GetGlobalElement(strElementName)
Returns the dispatch interface of the global element strElementName owned by page Page1.

GetNextPage Parameter string

Example Contents.GetPage(“Page1”).GetNextPage()
Returns the dispatch interface of the next page of page Page1.

GetPreviousPage Parameter string

Example Contents.GetPage(“Page1”). GetPreviousPage()
Returns the dispatch interface of the previous page of page Page1.

SetBGColor Parameter byte, byte, byte

Example Contents.GetPage(“Page1”).SetBGColor(255,255,255)
Sets the background color of page Page1.

BGColorR Parameter

Example Contents.GetPage(“Page1”).BGColorR =255
i= Contents.GetPage(“Page1”). BGColorR
Returns or changes the R value of the background color of the page Page1.

BGColorG Parameter

Example Contents.GetPage(“Page1”). BGColorG =255
i= Contents.GetPage(“Page1”). BGColorG
Returns or changes the G value of the background color of the page Page1.

BGColorB Parameter

Example Contents.GetPage(“Page1”). BGColorB =255
i= Contents.GetPage(“Page1”). BGColorB
Returns or changes the B value of the background color of the page Page1.

BGImage Parameter string

Example Contents.GetPage(“Page1”).BGImage=“C:\Documents and Settings\My Documents\A.img”
Path= Contents.GetPage(“Page1”).BGImage
Returns or changes the absolute path to the background image of the page named Page1.

Contents.GetPage(“Page1”).BGImage=“A.img”
Path= Contents.GetPage(“Page1”).BGImage
Returns or changes the relative path to the background image of the page named Page1. You 
should enter a relative path in the script if a file is attached through the Appending window 
or a file is included in the imported element. This is because the path information is included 
during packaging.

BGFillRatio Parameter

Example Contents.GetPage(“Page1”).BGRatio=0
i= Contents.GetPage(“Page1”).BGRatio
Returns or changes how the background image is filled in the page Page1.

newVal:
0: Original Size
1: Fit to Screen
2: Lock Aspect Ratio
3: Tile Effect
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Script Functions for the Element Object

Move Parameter int, int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Move(10,10)
Moves by (10, 10) the element elem1 owned by page Page1.

Resize Parameter int, int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Resize(100,100)
Resizes to (100, 100) the element elem1 owned by page Page1.

ShowEffect Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Figure Bevel”).ShowEffect(strEffectName)
Starts the play effect called strEffectName that is applied to the authoring element.

Visible Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Visible = true or false
Sets whether to display or hide the element elem1 of page Page1.

Rotation Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Rotation(60)
Rotates the element elem1 owned by page Page1 by 60 degrees.

Reflection Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Reflection(0)
Calls the Reflection function with parameter 0 for element elem1 owned by page Page1.

newVal:
0: None
1: Horizontal-Reflection
2: Vertical-Reflection
3: Horizontal and vertical reflection

PositionX Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).PositionX
Returns or changes the Position X value of the element elem1 of the page Page1.

PositionY Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).PositionY
Returns or changes the Position Y value of the element elem1 of the page Page1.

Width Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Width
Returns or changes the width of the element elem1 of the page Page1.

Height Parameter int

Example Contents.GetPage(“Page1”).GetElement(“elem1”).Height
Returns or changes the height of the element elem1 of the page Page1.
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Scripts for the Common Object

Name Parameter

Example name=Contents.Name
Contents.Name =“test”
Returns or changes the name of the content item.

GetParent Parameter

Example Contents.GetPage(“Page1”).GetParent()
Returns the dispatch interface of the parent of page Page1.

EventEnable Parameter

Example Contents.EventEnable
Shows whether the element being authored will respond to events, such as mouse click 
events, during playback.

Scripts for the System Utility Object

Sleep Parameter int

Example Utility.Sleep(i)
Makes the content sleep for i milliseconds.

RunProgram Parameter string, string

Example Utility.RunProgram(“C:\Documents and Settings\..”,“listName”)
Runs the process of the corresponding path. The second parameter is the argument list to be 
passed to the process.

OpenWebPage Parameter string

Example Utility.OpenWebPage(“www.samsung.com”)
Opens the www.samsung.com website using a web browser.

SendCopyData Parameter string, int, string

Example Utility.SendCopyData(“windowTitle”, 10, “abc”)
Sends the number data 10 and string abc to window windowTitle.

Scripts for the Event Information (EventInfo)

SenderName Parameter string

Example Utility.SenderName(“EventName”)
Returns the name of the element being authored that triggerred the event called EventName.
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Scripts for the Element Object

RSS

SetRssUrl Parameter string

Example Contents.GetPage(“Page1”).GetElement(“RSS”).SetRssUrl(“www.samsung.com/rss”)
Sets the URL of the RSS element to www.samsung.com/rss.

GetDesc Parameter int

Example Contents.GetPage(“Page1”).GetElement(“RSS”).GetDesc(i)
Returns the body text of the ith item in the RSS list.

GetItemCount Parameter

Example Contents.GetPage(“Page1”).GetElement(“RSS”).GetItemCount()
Returns the count of the items in the RSS list.

GetTitle Parameter int

Example Contents.GetPage(“Page1”).GetElement(“RSS”).GetTitle(i)
Returns the title of the ith item in the RSS list.

GetPubDate Parameter int

Example Contents.GetPage(“Page1”).GetElement(“RSS”).GetPubDate(i)
Returns the publishing date of the ith item in the RSS list.

Weather

GetLocation Parameter

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetLocation()
Returns the location corresponding to the Weather element Weather1 owned by page Page1 
that provides users with weather information.

GetDayofWeek Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetDayofWeek(i)
Returns the ith day’s weather information displayed by the Weather element Weather1 of the 
page Page1.

GetDate Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetDate(i)
Returns the ith date of the month for which the weather element Weather1 owned by the 
page Page1 provides users with weather information.

GetHigh Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetHigh(i)
Returns the highest temperature of the ith day’s weather information displayed by the 
Weather element Weather1 of the page Page1.

GetLow Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetLow(i)
Returns the lowest temperature of the ith day’s weather information displayed by the Weather 
element Weather1 of the page Page1.

GetTextWeather Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetTextWeather(i)
Returns the ith day’s weather information displayed by the Weather element Weather1 of the 
page Page1, in text format.
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GetImagePath Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).GetImagePath(i)
Returns the path of the image used to represent the weather information for the ith day 
displayed by the Weather element Weather1 of the page Page1.

SetRssUrl Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Weather1”).SetRssUrl(“www.yahoo.com”)
Retrieves the weather information of the Weather element Weather1 owned by page Page1, 
from www.yahoo.com.

Text

GetText Parameter string

Example Contents.GetPage(“Page1”).GetText(“text”)
Returns the string saved in the Text element owned by page Page1.

SetText Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Text”).SetText(“test”)
Makes the Text element Text owned by page Page1 display the text test.

SetTextFilename Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Text”).SetTextFilename(“C: …a.txt”) or
Contents.GetPage(“Page1”).GetElement(“Text”).SetTextFilename(“a.txt”)
The Text element Text on Page1 displays the contents of the a.txt file from the absolute or 
relative path.

SetTextColor Parameter int, int, int

Example Call Contents.GetPage(“Page1”).GetElement(“Text”).SetTextColor(255, 255, 255)
Sets the RGB values for the color of the Text element of the page Page1 to 255,255,255.

SetTextRTF Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Text”).SetTextRTF()
The Text element contained on Page1 displays a string in rich text format (RTF).

Image

GetCurImage Parameter

Example Contents.GetPage(“Page1”).GetElement(“Image”).GetCurImage( )
Returns the location of the image file that is applied to the Image element of the page Page1.

SetImage Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Image1”).SetImage(“C: …a.bmp”) or
Contents.GetPage(“Page1”).GetElement(“Image1”).SetImage(“a.bmp”)
The Image element Image1 on Page1 displays the image of the a.bmp file from the absolute 
or relative path.

SetOpacity Parameter int

Example Contents.GetPage(“Page1”).GetElement(“Image1”).SetOpacity(50)
Makes the Image element Image1 owned by page Page1 display the image with an opacity of 
50% (Can be set from 0 to 100).
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SetSubImageFile Parameter string,boolean,boolean

Example Call Contents.GetPage(“Page1”).GetElement(“Image”).SubImageFile(“C: …a.bmp”, true, false) 
or
Call Contents.GetPage(“Page1”).GetElement(“Image”).SubImageFile(“a.bmp”, true, false)

Displays the secondary image a.bmp from the absolute or relative path of the Image element 
on Page1, over the original image regardless of the original image size.

RemoveSubImage Parameter

Example Contents.GetPage(“Page1”).GetElement(“Image”).RemoveSubImage()
Removes the secondary image of the Image element owned by page Page1.

Sound

Play Parameter

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).Play()
Plays the Sound element Sound1 owned by page Page1.

Stop Parameter

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).Stop()
Stops playing the Sound element Sound1 owned by page Page1.

Pause Parameter

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).Pause()
Pauses playing the Sound element Sound1 owned by page Page1.

Reload Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).Reload(“C: …a.mp3”) or
Contents.GetPage(“Page1”).GetElement(“Sound1”).Reload(“a.mp3”)
Reloads the Sound element, replacing Sound1 on Page1 with the a.mp3 file located at the 
absolute or relative path.

SetClipTime Parameter int, int

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).SetClipTime(i, j)
Clips the Sound element Sound1 owned by page Page1, from i to j.

Mute Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“Sound1”).Mute(true)
Mutes the sound from the Sound element Sound1 owned by page Page1.

Video

Play Parameter

Example Contents.GetPage(“Page1”).GetElement(“Video1”).Play()
Plays the Video element Video1 owned by page Page1.

Stop Parameter

Example Contents.GetPage(“Page1”).GetElement(“Video1”).Stop()
Stops playing the Video element Video1 owned by page Page1.

Pause Parameter

Example Contents.GetPage(“Page1”).GetElement(“Video1”).Pause()
Pauses playing the Video element Video1 owned by page Page1.
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Reload Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Video1”).Reload(“C: …a.avi”) or
Contents.GetPage(“Page1”).GetElement(“Video1”).Reload(“a.avi”)
Reloads the Video element, replacing Video1 on Page1 with the a.avi file located at the 
absolute or relative path.

SetClipTime Parameter int, int

Example Contents.GetPage(“Page1”).GetElement(“Video1”).SetClipTime(i, j)
Clips the Video element Video1 owned by page Page1 from i to j.

Mute Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“Video1”).Mute(true)
Mutes the sound from the Video element Video1 owned by page Page1.

Camera

Play Parameter

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).Play()
Plays the Camera element Camera1 owned by Page1.

Stop Parameter

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).Stop()
Stops playing the Camera element Camera1 owned by Page1.

Pause Parameter

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).Pause()
Pauses playing the Camera element Camera1 owned by Page1.

IsPlaying Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).IsPlaying()
Returns as a BOOL whether the Camera element Camera1 owned by page Page1 is being 
played or not.

IsPaused Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).IsPaused()
Returns as a BOOL whether Camera element Camera1 owned by page Page1 is being paused 
or not.

IsStopped Parameter boolean

Example Contents.GetPage(“Page1”).GetElement(“Camera1”).IsStopped()
Returns as a BOOL whether Camera element Camera1 owned by page Page1 is being stopped 
or not.

Chart

SetCharData Parameter string

Example Contents.GetPage(“Page1”).GetElement(“bar”).SetChartData(“abc.xml”)
Imports the contents of the abc.xml file into the Chart element bar of the page Page1.
Either the absolute path or relative path can be entered as the file location.
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Flash

ReloadFilePath Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Flash”).ReloadFilePath(strFilePath)
Reset the external file for the Flash element contained on Page1 to the absolute path entered 
as a parameter.

ReloadURLAddress Parameter string

Example Contents.GetPage(“Page1”).GetElement(“Flash”).ReloadURLAddress(strURLAddress)
Reset the URL address for the Flash element contained on Page1 to the URL in the absolute 
path entered as a parameter.

Script Application Examples
Let's create more complex scripts on the basis of the script usage described above.

(Example 1) Moving Ball
This example creates a rotating Rectangle element that moves within the resolution of the Stage window. The Rectangle element 
moves and changes in size as well. In addition, if the element reaches the end of the X or Y axis of the resolution, it bounces.

This example created the movements and size changes by using the “if...then...else” statement. In addition, since an element 
executes the script command at very high speed, the execution speed has been slowed down by using the Timer element.
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Add the Rectangle and Timer elements to the Stage window first.

Set the Elapse property of the Timer element to "50" and set the <Event 
Type> to <Periodic>. Also set the Name property of the Rectangle element to 
“Ball”.
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In this example, you have to create two functions. The first one will define the two global variables “modeX” and “modeY”, which contain 
the direction of the element that will be processed when the content starts, and then set both of them to “0”. The second one will create a 
function that implements the movement and size change of the Rectangle element in the Timer element.

Note The Rectangle element moves very fast because its movement is determined by the processing speed of the CPU. In order 
to slow down the movement, the Timer element is used in this example to trigger timer events and execute an instant stop 
command whenever a timer event is triggered.
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When you start the content item, create a function that saves the direction of the movement in a global variable. Select the Stage window, 
click the  button in the Properties window, and click <Edit…> in the Event window or click the  button on the toolbar to launch the 
Script Editor.
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Click the  button at the bottom left and add a user function to open the 
Define Function window. Enter the function name (e.g. Init). You do not need 
to set the Parameter.

When creating a function is complete, click OK.
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Click <Supported Functions> at the bottom left and select Contents from 
the directory tree on the left side of the window to view a list of available 
functions at the bottom. If you select SetGlobalVar from the function list, the 
<Parameter Helper> appears.

In the Parameter Helper window, enter the parameter name (e.g. “modeX”) in 
the first column and enter the parameter value as “0” in the second column.
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In the next row, select SetGlobalVar, enter the parameter name as “modeY” 
and the parameter value as “0”.

When the parameters are entered as shown in the figure, click the Save 
button.

Note The values of “modeX” and “modeY” can be set to “0” or “1”. 
“0” represents a negative direction and “1” represents a positive 
direction, where X denotes the X-axis and Y the Y-axis.
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Select the Event tab at the top, check the AM_EVT_OBJECT_START checkbox 
and click the Apply button to apply the function you have created above to the 
corresponding event.
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Then create a function that controls the movement and the change of size of 
the Rectangle element, in the Timer element.
Select the <User Function> tab at the bottom left and click the  button to 
add a <user function>. Enter the Function Name as “MovingBall” and do not 
set the parameter.
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Write the function in the Edit field.

Declare the variables to save the location and size of the ball to. The Screen (X,Y,W,H) variables will have the values of the resolution of 
the screen. The X,Y,W,H variables will have the position values of an actual element. X denotes the positive X coordinate direction; Y the Y 
coordinate direction, W the width, and H the height.

screenX = 0
screenY = 0
screenW = Contents.ResolutionWidth
screenH = Contents.ResolutionHeight
X = Contents.GetPage(“Page1”).GetElement(“Ball”).PositionX
Y = Contents.GetPage(“Page1”).GetElement(“Ball”).PositionY
W = Contents.GetPage(“Page1”).GetElement(“Ball”).Width
H = Contents.GetPage(“Page1”).GetElement(“Ball”).Height1
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Set the amount of movement variation of the Ball element to 20 pixels and the amount of size variation to 10 pixels.

offset = 20
size = 10

The code above gets the values of the global variables previously defined in the “Init” method.

modeX = Contents.GetGlobalVar(“modeX”)
modeY = Contents.GetGlobalVar(“modeY”)
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Using the if...then...else statement, construct the movement of the ball.

if X - offset < screenX then
         X = screenX + offset
         modeX = 0
elseif X + W + offset > screenW then
         X = screenW - W - offset
         modeX = 1
elseif Y - offset < screenY then
         Y = screenY + offset
         modeY = 0
elseif Y + H + offset > screenH then
         Y = screenH - H - offset
         modeY = 1
end if
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Redefine the variables “modeX” and “modeY” with the values of modeX and modeY changed by the statements above.

Contents.SetGlobalVar(“modeX”,modeX)
Contents.SetGlobalVar(“modeY”,modeY)
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Using the if...then...else statement, construct the size-change of the ball.

if modeX = 0 then
         X = X + offset
         W = W + size
         H = H + size
else
         X = X - offset
         W = W - size
         H = H - size
end if
         if modeY = 0 then
         Y = Y + offset
         W = W + size
         H = H + size
else
         Y = Y - offset
         W = W - size
         H = H - size
end if
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Redefine the variables “X” and “Y” with the ball's location values changed by the statements above and variables “W” and ”H” with the size 
values.

Contents.GetPage(“Page1”).GetElement(“Ball”).PositionX = X
Contents.GetPage(“Page1”).GetElement(“Ball”).PositionY = Y
Contents.GetPage(“Page1”).GetElement(“Ball”).Resize(W,H)
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Define the rotation of the ball. Set the rotation angle to 10 degrees.

R = Contents.GetPage(“Page1”).GetElement(“Ball”).Rotation
R = R + 10

if R > 359 then
         R = 0
end if

Contents.GetPage(“Page1”).GetElement(“Ball”).Rotation = R
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When the statements are entered as shown by the figure, click the Save 
button.
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click the Apply button to apply the function you have created above to the 
corresponding event.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Check if the “MovingBall” method is displayed to the right of the AM_EVT_
TIMER_Timer event.
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2
1

3

You can find that the element changes in size, rotates, and moves.

￼ 1  The element changes in size.
￼ 2  The element rotates clockwise.
￼ 3  The element moves toward the end of the resolution.
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(Example 2) Creating a Button-Type Photo Album
When the content item starts, six button type photos are displayed at the bottom of the screen. Click a button to display the 
photo of the corresponding button as the background image of the whole content item.

You can implement displaying a photo relatively simply by using the function in the Script Editor in the AM_EVT_CLICK event.
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Register two Image elements to the Stage window which are to be used as photo albums. (In this example, it consists of 6 images). 
Register two images for each one because one is used as a background image and the other one is used as a button.1
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When you arrange the images, set the image to be displayed as a background image to Fit to Screen. Also, resize the image element to be 
used as a button to the required size.
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Set the order of the background images and button images to be played. Let the background images 1 to 6 come first and the button 
images follow them. The order of the images can be changed by adjusting the order of the time bars in the Timeline window. The higher 
the bar is in the Timeline, the later the image is displayed.
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Set the Name for each image. (E.g. Set the names of the background images 
1 to 6 to poster_01 to poster_06 and the button images to poster_01_1 to 
poster_06_1.)

Positioning the images is complete as shown in the picture on the left. 
Background images other than the one displayed in the picture are 
overlapping each other according to their orders.1
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In this example, 12 elements are used. There are many similar or duplicate 
elements and you can manage the elements using the Layer function of the 
Timeline window.

Separate the elements into two layers, a layer containing background images 
and a layer containing button images.
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In this example, we will write seven methods. We should write the function for the event that occurs when each button Image element is 
clicked and the function to set the default Opacity of each element when the content starts.
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Write the function to set the default Opacity of each element when the content item starts. Select the Stage window, click the  button 
in the Properties window, and click <Edit...> in the Event window or click the  button on the toolbar to launch the Script Editor.
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Click the  button at the bottom left and add a user function to open the 
<Define Function> window. Enter the function name (e.g. Init). You do not 
need to set the <Parameter>.

When the Define Function is complete, click OK.



175

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19
Click Supported Functions at the bottom left and select poster_01_1 of Page1 
below Contents from the directory tree on the left side of the window. A list of 
available functions will appear at the bottom. If you select SetOpacity from the 
function list, the Parameter Helper appears. In the Parameter Helper window, 
set the value to 50.
In the same manner, set the opacity to 50 using the SetOpacity function for 
poster_02_1, poster_03_1, poster_04_1, poster_05_1 and poster_06_1.

Each button image will have an opacity of 50 when the content item starts.
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After setting the Opacity of all the button images to "50", set the Visible 
property for each background image element to false.

Click <Supported Functions>, select poster_01 of page1 below Contents from 
the directory tree on the left side of the window and select Visible from the list 
of functions at the bottom.

Contents.GetPage(“Page1”).GetElement(“poster_01”).Visible =

is added. Modify this statement as follows.

Contents.GetPage(“Page1”).GetElement(“poster_01”).Visible = false

 
In the same manner, change the Visible property to false for poster_02, 
poster_03, poster_04, poster_05 and poster_06.
The background images are hidden when the content item starts.
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When the function has been created, click the Save button and the Event tab 
at the top. Select AM_EVT_OBJECT_START and click the Apply button to apply 
the created function to the event.
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Next, for each button image, we will write the function to control how the image is moved, and the function to control how the 
background image is displayed when it is clicked. Select the first button image element, click the  button in the Properties window to 
open the Event window and click <Edit…> or click the  button on the toolbar to launch the Script Editor.
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Click the  button at the bottom left and add a user function to open the 
Define Function window. Enter the function name (e.g. ShowImage1). You do 
not need to set the Parameter.

When the Define Function is complete, click OK.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Write the function in the Edit field. Write the function for the background image that will appear when the first button image element is 
clicked. (E.g. The first button is called “poster_01_1” and the corresponding background image is called “poster_01”.)

Contents.GetPage(“Page1”).GetElement(“poster_01_1”).SetOpacity(100)
Contents.GetPage(“Page1”).GetElement(“poster_02_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_03_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_04_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_05_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_06_1”).SetOpacity(50)

Make the five button images except the first button image have an Opacity of "50" when the first button image is clicked.

Contents.GetPage(“Page1”).GetElement(“poster_01”).SetOpacity(100)

The first button image will have an Opacity of 100%. The higher the “Opacity” (0 ~ 100), the closer the image is to the original image.

Contents.GetPage(“Page1”).GetElement(“poster_01”).Visible = true
Contents.GetPage(“Page1”).GetElement(“poster_02”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_03”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_04”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_05”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_06”).Visible = false

Hide the five background images except for the first background image when the first button image is clicked.

When the function has been created, click the Save button and the Events tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Write the function for the background image that appears when the second button Image element is clicked. (E.g. The second button is 
called “poster_02_1” and the corresponding background image is called “poster_02”.)

Contents.GetPage(“Page1”).GetElement(“poster_01_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_02_1”).SetOpacity(100)
Contents.GetPage(“Page1”).GetElement(“poster_03_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_04_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_05_1”).SetOpacity(50)
Contents.GetPage(“Page1”).GetElement(“poster_06_1”).SetOpacity(50)

Contents.GetPage(“Page1”).GetElement(“poster_01”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_02”).Visible = true
Contents.GetPage(“Page1”).GetElement(“poster_03”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_04”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_05”).Visible = false
Contents.GetPage(“Page1”).GetElement(“poster_06”).Visible = false

Hide the five background images except for the second background image when the second button image is clicked.

When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Create the functions for each of the button images poster_03_1, poster_04_1, poster_05_1 and poster_06_1 and for the background 
images poster_03, poster_04, poster_05 and poster_06 according to the procedures of 
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 and 
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.
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The content screen starts The first button image is clicked.

The third button image is clicked. The fifth button image is clicked.

(Example 3) Creating Weather Information
The weather for today is displayed on the first page when the content item starts.
The weather information will contain the date, day of the week, weather, and temperature etc. for today. If the highest 
temperature for today is higher than 15 degrees Celsius, HOT is displayed. If the temperature is lower than 15 degrees Celsius, 
COLD is displayed.
Moreover, if a certain condition is met, the background is changed in accordance with that condition. For example, if the weather 
for today is Sunny, a sunny background is displayed. If there is Snow, a snowy background is displayed. The second page will 
display a three-day weather forecast including today’s.

This example implements the changes in the background screen using the “if..then..else” statement, a conditional statement of 
the VB Script, and displays the weather information using the scripts for a Weather element.

Note In this example, a Weather element is used. To use this element, you need to set the location you want to display weather 
information for using the Properties window of the Weather element. In addition, you have to add a Weather element to both the 
pages to be created. The Weather element can only be found in the Timeline window. It cannot be found in the Stage window.
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First, we will design the elements for each page. For the first page, we will implement the weather for today. The following elements are 
needed to implement the weather for today: a Weather element, Word Art elements to display the title, etc., Text elements to display the 
weather information, and Image elements to display the weather graphically.1
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Register the required elements and design them appropriately. Place the 
Image elements to be used as the background in full screen according to 
the desired order. This example needs three background Image elements, 
one default background Image element, five Text elements for the weather 
information, one Word Art element for the title, two Word Art elements to 
display COLD and HOT, and one Weather element.

The background image shown in the figure is the default background image. 
Other background images are hidden because they are placed under the first 
one according to their order. Set the page title to Today_we.
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Set the Name of each element in the Properties window of the element. You can call an element more easily by calling it by its Name in 
the function when writing a script.
(Weather information text: Today1 ~Today5, Image element: Sun, Rain, Snow, WordArt element: HOT1, COLD1, Default background 
screen: base)

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Now let's design the second page. Click the <Insert New Page> button ( ) 
in the Pageline window to add a new page. Set the page name to 3Days.
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Design the second page in the same way as the first page.

The following elements are required: Text elements to display each weather 
information item, Image elements to display the weather graphically, a Word 
Art element to display the title, and a Weather element to get the weather 
information. Set the names of the elements in the same way as for the first 
page.
(E.g.
Names of the Text elements to display the days of the week: 
DayOfWeek1, DayOfWeek2, DayOfWeek3
Names of the Image elements to display the weather images: 
Icon1, Icon2, Icon3
Names of the Text elements to display the highest temperatures: 
TempHigh1, TempHigh2, TempHigh3
Names of the Text elements to display the lowest temperatures: 
TempLow1, TempLow2, TempLow3 )
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Now let's write the script to display the weather information and execute the events.
First, write the script for the default configuration of the background Image elements and Word Art elements which will be displayed 
according to the conditions of the first page.
Select the Stage window, click the  button in the Properties window, and click <Edit…> in the Event window or click the  button on 
the toolbar to launch the Script Editor.
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Click the  button and add a user function to open the Define Function 
window. Enter the function name (e.g. Img). You do not need to set the 
Parameter.

When the Define Function is complete, click OK.
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Write the script that sets whether to display or hide the background image 
element when the content item starts. Click <Supported Functions> at the 
bottom left and select Sun of Today_we below Contents from the directory 
tree on the left side of the window to view a list of available functions at the 
bottom. If you select Visible from the function list, 

Contents.GetPage(“Today_we”).GetElement(“sun”).Visible = 

The above statement will be added. Modify this statement as follows:

Contents.GetPage(“Today_we”).GetElement(“sun”).Visible = false

Modify the other background image elements in the same way.

Contents.GetPage(“Today_we”).GetElement(“rain”).Visible = false
Contents.GetPage(“Today_we”).GetElement(“snow”).Visible = false
Contents.GetPage(“Today_we”).GetElement(“base”).Visible = true

Except for the default background Image element, set the Visible property 
of each background Image element to false. The default background image 
element should be set to true. Then the other background images except for 
the default background image are hidden when the content item starts.
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When the function has been created, click the Save button and the Event tab 
at the top. Select AM_EVT_OBJECT_START and click the Apply button to apply 
the created function to the event.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

Next, we will write the function to display the weather information for today. 
Select the Stage window, click the  button in the Properties window, and click <Edit…> in the Event window or click the  button on 
the toolbar to launch the Script Editor.
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Click the  button and add a user function to open the Define Function 
window. Enter the function name (e.g. Today_inf). You do not need to set the 
Parameter.

When the Define Function is complete, click OK.
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Write the function in the <Edit> field. First we will write the script to control the Text and Image elements used to display each weather 
information item.

a = “Date : ” +Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetDate(0)
Contents.GetPage(“Today_we”).GetElement(“Today5”).SetText(a)

This is the script to display today’s date. Return the date of today to the variable a by calling the “GetDate” function. Then display the 
value of a by calling the “SetText” function of the Today5 Text element. 0 denotes today, 1 is tomorrow, and 2 is the day after tomorrow. 
That is why you have to set the parameter of “GetDate” to 0 for the page you want to display today’s weather. The name of the Weather 
element is Weather_1.

b = “Day : ” + Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetDayofWeek(0)
Contents.GetPage(“Today_we”).GetElement(“Today4”).SetText(b)

This is the Script to display the day of the week for today. Return the day of the week for today to the variable b by calling the 
“GetDayofWeek” function. Then display the value of b by calling the “SetText” function of the Today4 Text element.

c = “Inf : ” + Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetTextWeather(0)
Contents.GetPage(“Today_we”).GetElement(“Today3”).SetText(c)

This is the script to display the weather information for today. Return the weather information for today to the variable c by calling the 
“GetTextWeather” function. Then display the value of c by calling the “SetText” function of the Today3 Text element.

d = “High : ” + Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetHigh(0)
Contents.GetPage(“Today_we”).GetElement(“Today2”).SetText(d)

This is the script to display the highest temperature for today. Return the highest temperature for today to the variable d by calling the 
“GetHigh” function. Then display the value of d by calling the “SetText” function of the Today2 Text element.

e = “Low : ” + Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetLow(0)
Contents.GetPage(“Today_we”).GetElement(“Today1”).SetText(e)

This is the script to display the lowest temperature for today. Return the lowest temperature for today to the variable e by calling the 
“GetLow” function. Then display the value of e by calling the “SetText” function of the Today1 Text element.

f = Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetImagePath(0)
Contents.GetPage(“Today_we”).GetElement(“Today_Img”).SetImage(f)

This is the script to display the weather image for today. Return the location of the weather image file for today to the variable f by calling 
the “GetImagePath” function. Then display the value of f by calling the “SetImage” function of the Today_Img Image element.
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Next, we will write the Script to display the background image to be changed according to the weather conditions.

if c = “Inf : Sunny” then
         Contents.GetPage(“Today_we”).GetElement(“base”).Visible = false
         Contents.GetPage(“Today_we”).GetElement(“sun”).Visible = true
elseif c =“Inf : Snow” then
         Contents.GetPage(“Today_we”).GetElement(“base”).Visible = false
         Contents.GetPage(“Today_we”).GetElement(“snow”).Visible = true
elseif c =“Inf : Rain” then
         Contents.GetPage(“Today_we”).GetElement(“base”).Visible = false
         Contents.GetPage(“Today_we”).GetElement(“rain”).Visible = true
end if

By using the "If…then…else" conditional statement, you can write the script which changes the background image according to the 
weather conditions. You can increase the number of weather conditions as required. The conditions can be any number or text which 
can be displayed on the screen, such as weather text, the weather image file location, the temperature, the day of the week, and the 
date. In this example, we implemented the different background images according to three conditions. In the script above, the variable c 
has the weather text value. Therefore, a different block of the conditional statement is executed according the value of the variable c. In 
accordance with the condition, the image called base is hidden and the weather image matching the condition is displayed.

g = Contents.GetPage(“Today_we”).GetElement(“Weather_1”).GetHigh(0)
if g > “15” then
         Contents.GetPage(“Today_we”).GetElement(“HOT1”).Visible = true
elseif g < “15” then
         Contents.GetPage(“Today_we”).GetElement(“COLD1”).Visible = true
end if

By using the "If…then…else" conditional statement, you can write the script to display whether the weather is COLD or HOT according to 
the condition. In the script above, the variable g is used as the conditional element. If g is greater than 15, HOT is displayed. If g is lesser 
than 15, COLD is displayed.
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When the function has been created, click the Save button and the <Event> 
tab at the top. Select AM_EVT_WEATHER_CHANGED and click the Apply 
button to apply the created function to the event.
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Next, for the second page, we will write the script to display the three day weather forecast. With the first page, we implemented the 
script by writing a function to display the weather information. While, with the second page, we will implement the script by writing a 
function for each element. The name of the Weather element is RSS_Weather.

A total of 12 functions will be written for the second page. Four pieces of information will be displayed daily. Therefore, a total of 12 
information items will be displayed for 3 days. The first method we will write is regarding the day of the week.

The name of the function is SetDayOfWeek1.

str = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetDayofWeek(0)
Contents.GetPage(“3Days”).GetElement(“DayOfWeek1”).SetText(str)

The function above returns the day of the week for today to the variable Str. Then, the function returns the value returned to variable Str 
to the Text element DayOfWeek1. For the first day, the parameter value of the function is 0.

The name of the function is SetDayOfWeek2.

str = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetDayofWeek(1)
Contents.GetPage(“3Days”).GetElement(“DayOfWeek2”).SetText(str)

The function above returns the day of the week of the second day to the variable Str. Then, the function returns the value returned to 
variable Str to the Text element DayOfWeek2. For the second day, the parameter value of the function is 1.

The name of the function is SetDayOfWeek3.

str = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetDayofWeek(2)
Contents.GetPage(“3Days”).GetElement(“DayOfWeek3”).SetText(str)

The function above returns the day of the week of the third day to the variable Str. Then, the function returns the value returned to 
variable Str to the Text element DayOfWeek3. For the third day, the parameter value of the function is 2.

Make the five background images except for the second background image hidden when the second button image is clicked.

When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Then we will write the function for the weather image.
The name of the function is SetIcon1.

path = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetImagePath(0)
Contents.GetPage(“3Days”).GetElement(“Icon1”).SetImage(path)

The weather image file location for the first day is returned to the variable Path. Then, the function returns the value returned to the 
variable Path to the Image element Icon1. For the first day, the parameter value of the function is 0.
The name of the function is SetIcon2.

path = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetImagePath(1)
Contents.GetPage(“3Days”).GetElement(“Icon2”).SetImage(path)

The weather image file location for the second day is returned to the variable Path. Then, the function returns the value returned to 
variable Path to the Image element Icon2. For the second day, the parameter value of the function is 1.
The name of the function is SetIcon3.

path = Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetImagePath(2)
Contents.GetPage(“3Days”).GetElement(“Icon3”).SetImage(path)

The weather image file location for the third day is returned to the variable Path. Then, the function returns the value returned to variable 
Path to the Image element Icon3. For the third day, the parameter value of the function is 2.
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The name of the function is SetTempHigh1.

str = “High : ” + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetHigh(0)
Contents.GetPage(“3Days”).GetElement(“TempHigh1”).SetText(str)

The function above returned the highest temperature of the first day to the variable Str. Then, the function returned the value returned to 
variable Str to the Text element TempHigh1. For the first day, the parameter value of the function is 0.
The name of the function is SetTempHigh2.

str = “High : “ + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetHigh(1)
Contents.GetPage(“3Days”).GetElement(“TempHigh2”).SetText(str)

The function above returned the highest temperature of the second day to the variable Str. Then, the function returned the value returned 
to variable Str to Text element TempHigh2. For the second day, the parameter value of the function is 1.
The name of the function is SetTempHigh3.

str = “High : “ + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetHigh(2)
Contents.GetPage(“3Days”).GetElement(“TempHigh3”).SetText(str)

The function above returned the highest temperature of the third day to the variable Str. Then, the function returns the value returned to 
variable Str to Text element TempHigh3. For the third day, the parameter value of the function is 2.
The name of the function is SetTempLow1.

str = “Low : “ + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetLow(0)
Contents.GetPage(“3Days”).GetElement(“TempLow1”).SetText(str)

The function above returned the lowest temperature of the first day to the variable Str. Then, the function returns the value returned to 
variable Str to Text element TempLow1. For the first day, the parameter value of the function is 0.
The name of the function is SetTempLow2.

str = “Low : “ + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetLow(1)
Contents.GetPage(“3Days”).GetElement(“TempLow2”).SetText(str)

The function above returned the lowest temperature of the second day to the variable Str. Then, the function returned the value returned 
to variable Str to Text element TempLow2. For the second day, the parameter value of the function is 1.
The name of the function is SetTempLow3.

str = “Low : “ + Contents.GetPage(“3Days”).GetElement(“RSS_Weather”).GetLow(2)
Contents.GetPage(“3Days”).GetElement(“TempLow3”).SetText(str)

The function above returned the lowest temperature of the third day to the variable Str. Then, the function returned the value returned to 
variable Str to Text element TempLow3. For the third day, the parameter value of the function is 2.
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When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_OBJECT_START and click the 
Apply button to apply the created function to the event.

After you confirm that the functions are applied, click the preview button ( ) to check the events.
The content starts. The first page is displayed as follows:
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The weather information for today is displayed with a 
sunny sky image in the background, which appears when 
the weather info. indicates Sunny.

The weather information for today is displayed with a snowy image in the 
background, which appears when the weather info. indicates Snow.

The weather information for today is displayed with a 
rainy image in the background, which appears when the 
weather info. indicates Rainy.

The second page is displayed as above.
The weather information for 3 days including today is 
displayed.
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(Example 4) Creating a Calendar
When the content item starts, the numbers 1 to 12 representing the months of the year are displayed. When you click a number, 
you are moved to the calendar of the selected month. The calendar consists of a total of 13 pages. You can navigate the pages 
freely. The main focus of this example is to implement the navigation of the pages using Scripts.
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First, we will design the index page. If you click a number on the index page, 
you are moved to the calendar of the selected month.
Necessary elements are the image elements for designing and the number 
elements to move to a month by clicking it.

Design the page any way you want.
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In the Pageline window, click Insert New Page ( ) to insert a new page for 
each month. Repeat adding new pages until 12 pages are added.
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With the 12 pages, design the calendar for each month from January to 
December and the buttons used to navigate the pages. Set the name of the 
First Page button to First; the Previous Page, Previous; the Next Page, Next; 
the Last Page, Last.
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Now, let's define the event scripts. 
First, we will write a script corresponding to each number of the index page. 
The names of the number elements for each month in the index page are set 
as follows: Jan for January, Feb for February, Mar for March, and so on. The 
names of the function are set to Jan~Dec, in the same manner.

Contents.MovePage (“Page2”)
Contents.MovePage (“Page3”)
Contents.MovePage (“Page4”)
...

For the index page, you only have to implement the navigation of the pages 
and we implement it simply using the MovePage method. 
Up to December, you only have to change the Page name to be passed as the 
parameter value.
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When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Now we have completed designing the index page. We will write the Script for 
each page corresponding to a month of the year.

For pages other than the index page, you only have to write the script for the 
buttons to navigate pages.
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First, construct the First Page button. Select the First Page button, create the First function in the Script Editor and write the script in the 
Edit field.

Contents.MovePage(Contents.GetFirstPage().Name)

In this script, we use the name of the GetFirstPage function as the parameter value of the MovePage function. The Name property of the 
GetLastPage function retrieves the name of the last Page object.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Then, construct the Previous Page button. Select the Previous Page button, create the Previous function in the Script Editor and write the 
script in the Edit field.

Contents.MovePage(Self.GetParent().GetPreviousPage().Name)

In this script, we use the name of the GetPreviousPage function as the parameter value of the MovePage function. However, the 
GetPreviousPage function we want to use does not exist in the list of sub functions of the Text element to which the script is to be applied. 
Therefore, we use Self.GetParent() to call the GetPreviousPage function from the list of sub functions of the Page2 element which is the 
top element of the Text element. Add the Name property to the parameter value in the same manner as the First button.1
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When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Now, construct the Next Page button. Select the Next Page button, create the Next function in the Script Editor and write the script in the 
Edit field.

Contents.MovePage(Self.GetParent().GetNextPage().Name)

In this script, we use the name of the GetNextPage function as the parameter value of the MovePage function. However, the GetNextPage 
function we want to use does not exist in the list of sub functions of the Text element to which the script is to be applied.
Therefore, we use Self.GetParent() to call the GetNextPage function from the list of sub functions of the Page2 element which is the top 
element of the Text element. We also use the Name property to construct the parameter value, as in the button above.
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When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Now, construct the Last Page button. Select the Last Page button, create the Last function in the Script Editor and write the script in the 
Edit field.

Contents.MovePage(Contents.GetLastPage().Name)

In this script, we use the name of the GetLastPage function as the parameter value of the MovePage function. The Name property of the 
GetLastPage function retrieves the name of the last Page object.

1

2 10

12

13

14

15

11
3

4

5

6

7

8

9

16

17

18 20

19

When the function has been created, click the Save button and the Event tab at the top. Select AM_EVT_CLICK and click the Apply button 
to apply the created function to the event.
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Once one page is constructed, you can copy the buttons and paste them to the other pages because the properties, design and script of 
the buttons are the same.
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After checking the application of the functions, click the preview button ( ) to check the events.
The content item starts. The first page is displayed as follows:
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If you click a number, you are moved to the corresponding page.

You can navigate the pages by clicking the buttons at the top right.
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Open Source Announcement 06
To send inquiries and requests for questions regarding open sources, contact Samsung via Email (oss.request@samsung.com). 

■ This product uses some software programs which are distributed under the OpenSSL Project.

OpenSSL License
Copyright (c) 1998-2004 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:
1)  �Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2)  �Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 

in the documentation and/or other materials provided with the distribution.
3)  �All advertising materials mentioning features or use of this software must display the following acknowledgment: 

“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.
org/)”

4)  �The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived from this 
software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5)  �Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in their names without prior 
written permission of the OpenSSL Project.

6)  �Redistributions of any form whatsoever must retain the following acknowledgment:  
“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written 
by Tim Hudson (tjh@cryptsoft.com).

MagicInfo Author
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Apache License, Version 2.0

Foundation Projects People Get Involved Download Support Apache Home >> Licenses

Apache License Version 2.0, January 2004

http://www.apache.org/licenses/ 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this 
document.

“Licensor” shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

“Legal Entity” shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common 
control with that entity. For the purposes of this definition, “control” means (i) the power, direct or indirect, to cause the direction 
or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the 
outstanding shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity exercising permissions granted by this License.

“Source” form shall mean the preferred form for making modifications, including but not limited to software source code, 
documentation source, and configuration files.

“Object” form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not 
limited to compiled object code, generated documentation, and conversions to other media types.

“Work” shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by 
a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

“Derivative Works” shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and 
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of 
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link 
(or bind by name) to the interfaces of, the Work and Derivative Works thereof.

“Contribution” shall mean any work of authorship, including the original version of the Work and any modifications or additions to 
that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner 
or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, 
“submitted” means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are 
managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication 
that is conspicuously marked or otherwise designated in writing by the copyright owner as “Not a Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by 
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a 
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative 
Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object 
form.
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3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a 
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to 
make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those 
patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of 
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work 
constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work 
shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or 
without modifications, and in Source or Object form, provided that You meet the following conditions:

You must give any other recipients of the Work or Derivative Works a copy of this License; and

You must cause any modified files to carry prominent notices stating that You changed the files; and

You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution 
notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

If the Work includes a “NOTICE” text file as part of its distribution, then any Derivative Works that You distribute must include 
a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any 
part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative 
Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated 
by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for 
informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works 
that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution 
notices cannot be construed as modifying the License. You may add Your own copyright statement to Your modifications and 
may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the 
conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the 
Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have 
executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names 
of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, 
either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of 
using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, 
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be 
liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as 
a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, 
work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor 
has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, 
and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this 
License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on 
behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability 
incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work
To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets “[]” 
replaced with your own identifying information. (Don’t include the brackets!) The text should be enclosed in the appropriate 
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on the 
same “printed page” as the copyright notice for easier identification within third-party archives.

		  Copyright [yyyy] [name of copyright owner]

		  Licensed under the Apache License, Version 2.0 (the “License”);
		  you may not use this file except in compliance with the License.
		  You may obtain a copy of the License at

			   http://www.apache.org/licenses/LICENSE-2.0

		  Unless required by applicable law or agreed to in writing, software
		  distributed under the License is distributed on an “AS IS” BASIS,
		  WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
		  See the License for the specific language governing permissions and
		  limitations under the License.
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